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Introduction
WebMD Ignite has aligned with Crownpeak as its exclusive healthcare web technology partner to create
the latest version of CMS. CMS was built leveraging the best of Crownpeak’s capabilities with WebMD
Ignite’s innovation.

The Crownpeak tool has been built with the marketer in mind, which makes editing in CMS intuitive and
easy. You can edit pages in a familiar browser mode without actually leaving the page. Most
importantly, your marketing team and content editors will no longer be dependent on IT or web
development support for simple site revisions. You are the editor, no coding required.

However, if you prefer markup or style language, the editing tools are just as intuitive and convenient.

CMS is designedwith themarketer inmind.Nocoding required.

Disclaimer
The screen samples included in this document may vary from those you see in your software, based on
configuration options selected. Samples are included to serve as a guide and training tool and are not
intended to represent actual replicas of screens in your software. Any patient names used in this
documentation are fictitious.
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Administrative
Edit your profile andpreferences

Edit profile

From the main left navigation menu, navigate toSettings (gear icon) for configuration options.

SelectEdit Profile to edit your profile.

Some of the things you can do here:
● Select an avatar/image
● Set username
● Set password to never expire (check ‘Mark as service account’}
● Change password
● Define user attributes
● Select Login option
● Associate groups

Edit preferences

Also from the main left navigation menu, navigate to Settings for configuration options. SelectEdit
Preferences to edit your preferences.
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Some of the things you can do here:
● Customize the first page you see after logging into the CMS (CMS start page).
● Control notifications
● Publishing preferences
● Content preview states
● Content debug options
● Set timezone and language preferences
● Initial view when opening an asset

CMSStart Page
● This preference allows you to customize the first page you see after logging into the CMS.
● For example, as configured in the image below, the system will automatically navigate to the

Site Root folder when you log in.
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Usermanagement
From the main left navigation menu, navigate toSettings for configuration options.

SelectUsers/Groups to edit your users.

Users

This section allows you to create new or manage current users associated with your CMS instance.

● To set up a new user, click theNewUserbutton and fill out the required fields.

● To edit an existing user, double-click a user’s name and editProfileorPreferencesusing the
tabs as shown below.

● Use this section to reset a user’s password.
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Groups

This section allows you to create new or manage current Groups associated with your CMS instance.
● To set up a new group, click theNewGroupbutton.
● To edit an existing group, click the user group name and follow the prompts.

Configuring site for SSOvia SAML/LDAP

For clients with single sign on (SSO) availability such as SAML/LDAP, the CMS can be configured to add
users in a way that they can leverage this functionality. If you want to set up SSO for your website login,
you will need to have your WebMD Ignite contact set up a conversation with your IT and the WebMD
Ignite and Crownpeak teams.

Authentication settings can be found by clicking theGear icon>Configuration>Authentication.
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Specific information your IT team will need to have available during that call includes:

SAML Identity Provider (IdP) (Section)
● Single Sign On URL (The identity provider URL to which SAML requests should be sent.)
● Issuer ID (Enter the Issuer ID of the identity provider.)
● Signing Certificate (Enter the public certificate of the identity provider.)
● Upload (Click this button to upload the configured information.)
● Remove (Click this button to remove the uploaded information.)

SAMLAttributeNames (Section)
Security Assertion Markup Language (SAML) open standard is the link between the authentication of a
user's identity and the authorization to use a service. SAML allows identity providers (IdP) to pass
authorization credentials to service providers (SP).

● Login (Enter the Attribute Name (Claim Type) that identifies the user's login name.)
● Email (Enter the Attribute Name (Claim Type) that identifies the user's email address.)
● First name (Enter the first name of the person.)
● Middle name (Enter the middle name of the person, if applicable.)
● Last name (Enter the last name of the person.)
● Groups (Enter groups as applicable.)

SAMLServiceProvider (SP) (Section)
● Single Sign On URL (Also known as the ACS URL. Enter the URL where SAML assertion responses

from the Identity Provider should be sent.)
● Audience URL (Enter the intended audience URL of SAML assertions. Also represents the

Service Provider.)
● Default Return URL (Enter the default URL to which the user should return following successful

authentication.)

Adding newSSOusers

Once SSO has been configured on your site, you can easily add new users via your existing SSO.
Click thegear icon to access theUserspanel. Then clickNewUser.
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Add the user’s SSO username into theUsernamefield, which must be supplied to you by the user or
your IT. Make sure to clickOnSave, RandomlyGenerate aOne-TimeUser Password.

Complete all the other remaining fields as you would for any normal user. The only exception is that you’ll
need to toggle theStandard LoginOptionunder Login Provider to your SSO login option.

Workflowmanagement
From the main left navigation menu, underSettings, Workflow provides configuration options for the
following categories:

● Workflows
● Workflow Filters

SelectWorkflow to access your workflows.
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AboutWorkflows

A Workflow describes a predefined lifecycle that can be applied to an asset (object, image, document,
or video) within the CMS.

The CMS allows you to set up as many Workflows as needed to support your business needs. This is
typically set up by a WebMD Ignite developer on your behalf and is rarely modified after.

The process of creating a Workflow involves defining automated steps that are invoked by configurable
actions such as triggers, filters, user interactions and/or conditions. These automated steps that follow
a configured action are called ‘transitions’. As an asset travels the Workflow path, the asset ‘transitions’
from one state to another.

To see the Workflow of an existing asset, right clickasset/file, then clickRoute. The options displayed
represent that asset’s workflow. For example, in the screenshot below, you can see this file follows the
‘IH Production Workflow’ and the states beginning with Draft thru Deleted are the stages of that
Workflow.

Workflowexamples

Some examples of how Workflows can be used are listed below by their description. These examples
are mostly custom built by WebMD Ignite’s developers, at your request, but most commonly used ones
are available out-of-the-box.

● Assets that should be published to all environments instantly upon creation
● Builds sitemap data in a Sitemap JSON file for consumption by sitemap files
● Development Workflow
● Full Workflow
● Microsite Workflow
● Normal page Workflow
● Production with Dev state
● Production Workflow
● Responsible for triggering the execution of custom upgrade actions
● QA Sanitizer Workflow

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 9



● Short workflow for shared assets
● Simple workflow - draft > live
● Site Builder Workflow
● Stage Workflow
● Testing Workflow
● The workflow the task management system uses
● This workflow allows only one doc to be live at a time so for the home page, you can schedule

the live date.

Workflowsout-of-the-box

While there are many examples of workflows, as listed above, there are only 2 commonly used
workflows used in the CMS today. Both are available out-of-the-box.

● IH Production Workflow
● IH Instant Publish

IH ProductionWorkflow

● Most assets follow this workflow.
● In this workflow, an asset begins in theDraft state. It can then transition to theStage state and

finally, once published, transition to a Live state.
● There are several other states in this workflow as shown below.
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Instant Publish
In some cases, we want to publish assets to Live instantly, without requiring the asset to be manually
routed through Stage. The purpose of this workflow is to ensure these types of assets are published
everywhere as soon as they are created.

The most common use for this workflow is for images used for Providers, Locations and Events within
Content Apps. Content Apps, by design, instantly publish to Live; therefore, the images must also be
instantly available when created. To achieve this, we associate this workflow with the folder
_Assets/Images/ih. This folder houses all the images created by the Content Apps section for those
modules.

For example, when we are in the Providers section of Content Apps and upload a physician photo,
Content Apps places that image in the ‘ih’ folder. Since IH Instant Publish is associated with that entire
folder, the image is instantly published to Live and the entire physician record is immediately published
to Live.

Creating newworkflowvsediting existingworkflow

While both options are available, it is often easiest to begin with an existing workflow and modify it to
create the desired workflow.

The Workflow settings are the same for both creating a new workflow or editing an existing workflow.
Those settings are described below.

It is strongly recommended that youcontact aWebMD Ignite developer to assist in creatingor
editingworkflows.

Workflowsettings

To access workflow settings:
● From the main left navigation menu, navigate toSettings (gear icon)
● SelectWorkflowson the left nav to access your existing workflows.
● From here you can

○ Create a new workflow (ClickNewWorkflowbutton on top right) OR
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○ Edit an existing workflow (Click workflow to be edited to open edit menu) OR
○ Clone and existing workflow and edit it to create a new workflow

To copy and edit an existing workflow, click an existing workflow that is similar to what you want. Select
Clone on the far right (as shown below) which will create a copy of the workflow. Then click the cloned
version of the workflow, which will open the Edit Workflow window.

After clicking theNewWorkflowbutton, or cloning an existing workflow, notice there are 3 clickable
panels available as shown in the screenshot below:
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All 3 panels are available for both New Workflow and Edit Workflow
● Overview - allows you to change the workflow
● Edit Steps - allows you to make changes to each step in the workflow.
● Reorder Steps - allows you to change the order of the steps within the workflow.

When creating a new workflow, it will open first to theEdit Stepspanel.
When editing an existing workflow, it will open first to theOverviewpanel.

Creating a newworkflow
The general process for creating a new workflow is enter

1. Name : Enter a name for the workflow
2. Description : Describe the workflow
3. Create all the Steps of the workflow first
4. Then configure each step in the workflow which includes Transitions and other settings, as

desired (Note: We do it this way because transitions can not be defined until the step we are
transitioning to is defined within the new workflow.)

Overviewpanel
The overview panel allows you to change the workflow
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Edit Stepspanel
The Edit Steps panel allows you to make changes to each step in the workflow.

There are many options here within the Edit Steps panel to customize your workflow. Each workflow
state/step includes the following:

● Status* (This is a required field, as indicated by the asterisk (*). Displays the selected status.
Options available from the drop-down field include: Draft, Pending, Rejected, Stage,
Suspended, Live, Retired, Archived, Deleted, Not Started, In Progress, Parking Lot, Deferred,
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Completed, Closed, Approved, QA, Dev, Sanitize Failure, Sanitize Success, Sanitize and Add
New Status,)

● Access* (Required. The Browse button takes you to theSystem/States folder. Generally you
will select the system state that matches the ‘Status’ you selected in the previous step. See
example below.

● Title* (This is a required field. You can edit the title of this workflow state.)
● Description (Enter a concise description for your workflow state, to help users understand its

intended use.)

Enable or deactivate the following options using the applicable checkbox:

● Enable publishing on this step.
● Include steps in the Edit menu.
● Set assets in this step as Deleted.
● Set assets in this step as Hidden.

Transitions
Configure transitions for this state.

● AddTransition (Click this button to add a new Transition panel.). See example below.

These transitions may be deleted and new ones added.
● Deploy toStageexample above(Expand this panel to customize behaviors that apply to this

transition.)

Inside each transition are configurable behaviors and filters including the following:
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● Transition Trigger (Options are User Command, Action and Schedule. Select a trigger. The
submenus change in context with your selection. Configure additional rules from the
contextual options that display. Our sample screen below displays User Command.

For example, a selection of User Command o�ers the following options:

● Whenauser selects...* (Required. Enter the UI selection that initiates the next step. For
example: Deploy to Stage.)

● ...Go toStep* (Required. Choose from the list of options Draft, Stage, Pending, Live, Retired,
Archived, Deleted. For example, we chose Stage.)

● UsesWorkflowFilter (Choose a workflow filter from the list. In this example, options are; None,
Developer Filter and Editor Approval.)

Enable or deactivate the following options using the applicable checkbox.

● Include action in user's workflow tasks in their summary page.
● Include Action in editpage as a blue button.
● Prompt user with, “Are you sure?” before executing.
● Request a comment before going to the next step.
● Queue publishing in destination step.
● Enforce an edit/save before transition.
● Enforce a spell checkbefore transition.
● Enforce a set schedule before transition.
● Delete Transition (Click this button to delete this transition.)

Changeworkflow
Below the Transitions section, you can opt to change the workflow. Enable/deactivate using the
following checkbox.
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● Useadi�erentworkflow (Enable/deactivate using this checkbox.)

When enabled, this checkbox displays additional options for using a di�erent workflow.

● SelectWorkflow (This drop-down contains all of your previously-configured workflows)
● Select a Status (This drop-down containsRouting statuses such as the following: Draft,

Pending, Rejected, Stage, Suspended, Live, Retired, Archived, Deleted, Not Started, In
Progress, Parking Lot, Deferred, Completed, Closed, Approved, QA, Dev, Sanitize Failure,
Sanitize Success and Sanitize.)

DQM
Enable this to use DQM findings to prevent publishing.

Execute File
Select a template file to execute. (Select the new Document_Sanitizer.aspx template file, which will
execute on transition to this state, using the Browse button.)

Email Notification
Send selected users an email notification when an asset reaches this step. Enable/deactivate this
option using this checkbox. If enabled, this area expands to allow additional setup by Users and/or
Groups, based on USER ID in the system.

Delete This Step
Remove the entire step using this control.

Reorder Stepspanel
The Reorder Steps panel allows you to change the order of the steps within the workflow.

Document SanitizationWorkflow

Overview
To meet National Institute of Standards and Technology (NIST) requirements, the HG CMS application
sanitizes all downloadable Adobe PDF and MS O�ce® files of metadata containing Personally
Identifiable Information (PII).

Note: It does not removeanyPIIwithin the content of thosedocuments.

Personally-Identifiable Information includes any data that could potentially be used to identify a
specific person, that includes, but is not limited to employee ID names and numbers, or email
addresses that may reside in a document’s properties and header.

The sanitization process removes all of this metadata from uploaded PDF files, Word (.docx), Excel
(.xlsx) and PowerPoint (.pptx) files, eliminating the need for manual removal of PII prior to upload and
greatly reducing the potential for error.

The process workflow is configurable, with additional sanitization options. You can additionally
configureAuthorand editor comments to be removed from documents.
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SupportedMSO�ce®documents include theopen-xml versiononly anddonot includeolder
versions such as .doc .xls or .ppt, etc.

Documents are stored in theAssets folder. FromContent, this is usually under a path similar to ..Site
Root/_Pages/_Assets.

You canRoutedocuments from here to a sanitization state. Sanitization states are fully customizable
from theSettings>Workflow area. Follow the steps in Create a New Workflow if this option does not
exist.

Use the following documentation as a guide to setting up aDocumentationSanitizationWorkflow. As
stated earlier, it is recommended to involve WebMD Ignite’s developers when setting up any new
workflow.
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Workflowsettings forDocument Sanitization
Access Workflow fromSettings in the main left menu bar. You can create a new workflow here from the
NewWorkflowbutton or edit an existing workflow.

TheEditWorkflow screen displays. The vertical bars of the workflow, labeled by workflow state, are the
currently configured states. Below are their definitions.

Workflowstates
● Draft (When a document is uploaded, it automatically arrives in the Draft state. Documents in

this state are awaiting sanitization.)
● Sanitize (Although configurable, it is strongly recommended to use this workflow state.

Documents must enter this workflow state in order to be sanitized.)
● Sanitize Success (Configurable. Documents automatically transition to this state when the

sanitization succeeds.)
● Sanitize Failure (Configurable. Documents automatically transition to this state when the

sanitization fails.)
● Live (Configurable. This is the environment to which our document will be published on Sanitize

Success. In production, this would be Stage or Live.)

Theworkflowstate towhich adocument transitionson sanitization successor failure is
configurable.

Editingworkflow
You can configureWorkflow to suit your business needs. For example, you can have the document
sanitization start immediately upon upload, and when the sanitization succeeds, have the document
transition to Sanitization Success or straight to Live or Stage.
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ContentAppshas a Scheduled Task that runs continuously in the background looking for document
assets in need of sanitization. This process is detailed further in TheDocument Sanitizer Task–
Scheduled Tasks topic.

FromEditWorkflow, click on a vertical color bar to open the edit screen for that workflow state. You
can expand your view using the arrows as shown.

Editworkflowsteps
We clicked theSanitize Successworkflow state, which opens theEditWorkflow screen, depicted
below. There are many options here to customize your workflow. Each workflow state includes the
following:

Status* (This is a required field, as indicated by the asterisk (*). Displays the selected status (currently
Sanitize Success). Other options are available from the drop-down field and include: Draft, Pending,
Rejected, Stage, Suspended, Live, QA, Dev, Sanitize Failure, Sanitize Success, Sanitize and Add New
Status,)

● Access* (Required. The Browse button takes you to the System/States folder. The
displayed selection is System/States/Sanitize Success/.)

● Title* (This is a required field. You can edit the title of this workflow state.)
● Description (Enter a concise description for your workflow state, to help users understand its

intended use.)
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Enable or deactivate the following options using the applicable checkbox:

● Enable publishing on this step.
● Include step in Edit menu.
● Set assets in this step as Deleted.
● Set assets in this step as Hidden.

Transitions
Configure transitions for this state. We have used Draft and QA for our workflow demonstration.

● AddTransition (Click this button to add a new Transition panel.)

These transitions may be deleted and new ones added.

● Draft (Expand this panel to customize behaviors that apply to this transition.)
● QA (Expand this panel to customize behaviors that apply to this transition.)

The configurable behaviors and filters for this section are the same and include the following:
● Transition Trigger (Options are User Command, Action and Schedule. Select a trigger. The

submenus change in context with your selection. Configure additional rules from the
contextual options that display. Our sample screen below displays User Command.

For example, a selection of User Command o�ers the following options:

● Whenauser selects...* (Required. Enter the UI selection that initiates the next step. For
example: Draft.)

● ...Go toStep* (Required. Choose from the list of options Draft, Sanitize, Sanitize Success,
Sanitize Failure or QA.)

● UsesWorkflowFilter (Choose a workflow filter from the list. In this example, options are; None,
Developer Filter and Editor Approval.)

Enable or deactivate the following options using the applicable checkbox.

● Include action in user's workflow tasks in their summary page.
● Include Action in edit page as a blue button.
● Prompt user with, “Are you sure?” before executing.
● Request a comment before going to the next step.
● Queue publishing in destination step.
● Enforce an edit/save before transition.
● Enforce a spellcheck before transition.
● Enforce set schedule before transition.
● Delete Transition (Click this button to delete this transition.)
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Changeworkflow
Below the Transitions section, you can opt to change the workflow. Enable/deactivate using the
following checkbox.

● Useadi�erentworkflow (Enable/deactivate using this checkbox.)

When enabled, this checkbox displays additional options for using a di�erent workflow.

● SelectWorkflow (This drop-down contains all of your previously-configured workflows,
including our example: QA Sanitizer Workflow.)

● Select a Status (This drop-down containsRouting statuses such as the following: Draft,
Pending, Rejected, Stage, Suspended, Live, Retired, Archived, Deleted, Not Started, In
Progress, Parking Lot, Deferred, Completed, Closed, Approved, QA, Dev, Sanitize Failure,
Sanitize Success and Sanitize.)

Executefile
● Select a template file to execute. (Select the new Document_Sanitizer.aspx template file,

which will execute on transition to this state, using the Browse button.)

Email notification
● Send selectedusers an email notificationwhenan asset reaches this step.

(Enable/deactivate this option using this checkbox. If enabled, this area expands to allow
additional setup by Users and/or Groups, based on USER ID in the system.))

● Delete This Step. (Enable/deactivate using this control.)
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TheDocument Sanitizer Task–Scheduled Tasks
ContentApps>Configuration>Scheduled Tasks now includes a scheduledDocument Sanitizer task.
Enablement and scheduling for this task is configurable.

Basic Information Tab
From the edit screen, the leftBasicConfiguration tab displays the current settings and status of the
last run. Activate this task with theEnablecheckbox.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 23



Schedule Tab
The next tab down on the left in theScheduled Task [Task] edit screen is theSchedule tab.
Configuration options are as follows:

● Time Zone (This field is display only. Our example displays: Central Daylight Time. You can
select your time zone from the Time Zone Settings panel in Configuration > System Settings.)

● Schedule Type (Select from the available options, whether Continuous, Daily, Weekly, Monthly,
Day of Month, Time of Day.)

● Time of Day (Enter the time of day you want this task to run in hours (format: hh) and minutes
(format: mm). The AM/PM button toggles on click.)

SystemSettings–Document Sanitization
There is a new Document Sanitization section in theCMS IntegrationSettingspanel that allows you to
control target, success and fail workflow states as well as to enable or deactivate the removal of
reviewer comments from documents. Access these settings fromContentApps>SystemSettings.
Expand the CMS Integration Settings panel and scroll down to the Document Sanitization section.
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Enter information in the fields as follows:

● TargetWorkflowState (The displayed value is Sanitize. This is the state that activates the
sanitization process. Documents must be in this state in order to be sanitized.)

● SuccessWorkflowState (Enter the name of the workflow state to which the document should
transition on sanitization success. For example, Live.)

● FailWorkflowState (Enter the name of the workflow state to which the document should
transition on sanitization failure. For example, Draft.))

● RemoveComments (Enable/deactivate the removal of reviewer comments from
documents using this checkbox.)

Workflowfilters

Filters can redirect assets even from within the same workflow, based on the conditions you set, down
to the field level. Add new or delete existing filters with the controls illustrated below.

Configuration
TheConfiguration for your COD10 site is where you will create custom content types, set up redirects,
edit your navigation settings (main, footer, etc.), and make other major site-level configuration
changes.

Please note that you will see folders forAdvancedConfigurationand TaggingManagement in your
Configuration folder, but you will never need to access these. The main tasks you’ll need to accomplish
in the site configuration are outlined below with appropriate processes.

To access yourSiteConfigurationoptions, clickConfiguration in yourSiteRoot.
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HeliconRedirects
Use helicon redirects to create campaign URLs or to set up redirects. There are several ways to do this.
For the novice user, navigate to theHeliconRedirects folder under your site’s Configuration folder.
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Setting upa redirect
In your Helicon Redirects folder, open up theRedirects Folder:

Go toFile >New>HeliconRedirect:

A modal will present prompting you to name yourHeliconRedirect. Name it something appropriate so
that you can easily locate it in the future:
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You’ll be presented with a screen like this. ClickExpandat the top of the page to expand all of your divs:

Now you should see options forRequestedURL andDestinationURL:
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Your requestedURL is the current page that needs to be redirected somewhere else or the campaign
URL you’re wishing to create.

● If you’re wanting to create a campaign URL, simply enter the relative path of your campaign
URL, for example: /campaignURL

ThedestinationURL is the page where your redirect needs to go. This can be internal or external.
● If you plan on placing ads that append query strings to your URL, be sure to click the “Append

Query String from Original URL” box.

When done completing these fields,Saveand deploy to live.

Now you have to publish thehttp.conffile. The http.conf file can be found under yourHeliconRedirects
folder. Simply right click on the file and go toRoute>Publish to Live.
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Navigation configuration
The Navigation Configuration of your site allows you to edit and adjust the links for your site’s utility ,
header, and footer navigations.

Note:Not all sites use their navigation configuration for the utility navigation. Some use the
Configurable Header instead.

After you’ve opened your navigation configuration, click theExpandbutton at the top of the screen to
open up all of the link <div>s.
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Now you can edit, add, remove links from the utility navigation and utility nav dropdowns (using Sub
Menu Items), assuming your site is configured appropriately.

● Internal or External: Tells the site what type of link it is
● Link Text: The language you want to have show up in your menu
● Link Target: Tells the site how you want the link to open
● OptionalQuerystring: Add querystrings for tracking purposes

Complete these fields for all links that need to sit within your utility nav.Save and publish to live.

These same steps will hold true for yourHeaderNavigation.

TheFooterNavigation, on the other hand, is powered by a WYSIWYG:

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 31



We suggest you toggle to source code to make edits to your footer links.

After any edits to yourNavigationConfiguration, it is best practice to republish yourMaster Page,
which sits underAssets >Master.

In your navigation configuration, you will see another section for theSocialMediaMenu. You should
never need to edit this.

Search configuration
Your site’s search configuration should already be set up by the WebMD Ignite team during your site’s
development. You should never really need to edit this unless you want to change your search results
destination page, the number of search results that appear, and the length of result titles and
descriptions.
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You will never need to editCollections and sitesorCertificates.

Site configuration
Your site configuration file allows you to make edits to your site on a global level. There are several tabs
within your site configuration: Default Content Configuration, Master Page, Meta, Google Analytics,
SEO Properties, Article Configuration, Custom Content, and Snippets & Links

DefaultContentConfiguration lets you specify default content for certain areas of every page on your
site: banner, top, left, right, and bottom. Banner adds a banner image to each page. Top adds specific
content to the top of every page, and left, right, and bottom act respectively.

Top adds specific content to the top of every page, and left, right, and bottom act respectively.

TheMaster Page tab lets you determine your site’s logo as well as its height, width, alt text, and link
attributes. For Google Page Experience purposes, it is strongly recommended to include height and
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width attributes with your site logo. For ADA compliance purposes, it is strongly recommended to
include alt text with your logo.

TheMaster Page tab also gives you the option to edit a few other aspects of your site, the only two of
which you should ever consider editing areSiteContainer Layout TypesandBreadcrumb. Both of
these will be set up for you by youWebMD Ignite’s development team during your site implementation,
however, you can adjust the width span of your pages under site container layout types and the
breadcrumb enablement or disablement under Breadcrumb.

JSS andCSSFile settings are for Google Page Experience purposes. Social Media and Facility Address
are archived functionalities of the platform.

The last option under the Master Page tab is forSite Search. Typically, site search functionality on
COD10 sites is powered through widgets, so you shouldn’t need to edit this.
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On theMeta tab, you can make site-wide SEO updates. This is not recommended. However, if you need
to have your whole site not indexable by search engines, you could toggle the Select Robots Option to
noindex.nofollow.

On theGoogleAnalytics tab, you can add your UA Google Analytics tag as well as any other Custom
Analytics or tracking script that you might want to include as part of your master page. This could also
be added on the Snippets & Links tab to be covered.
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TheSEOProperties tab allows you to use fields and panels to configure SEO rules for creating a smart
page title for your web pages. The smart page title can be overridden at the page level by providing a
value for the "SEO Title" field.

TheArticlesConfigurationandCustomContent tabs are not widely used any longer, as they have been
replaced with custom content layouts and fields which o�er far more flexibility.
The last tab forSnippets&Links lets you quickly and easily place script or style into the </head>.
<body>, or </body> of every page of your site.
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Keep in mind that any changes made at the site configuration level can easily be overwritten at the
folder or page configuration level. Each folder and page gives you the option to inherit from the site
config, inherit and add, or not inherit at all.

It is good practice to republish the master page after making any changes to the site configuration, just
to be sure your changes propagate as intended.

Content
Static Pages

● Static pages are the most common type of page built within the CMS.
● They reside in the _Pages folder (directly under the main Site Root folder).
● With static pages, you can leverage everything from a simple WYSIWYG editor up to advanced

options including widgets and custom code.

Create/Edit pages

Very important! ALWAYScreate anduse folders andfiles from theModel section.

When creating new folders or pages of content, you should ALWAYS use theModel section.

● DO NOT use New > Folder or New > File.
● DO use New >Model> Folder or New > Model > Static Page
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Using Model will make use of templates that WebMD Ignite has supplied for that section and gives the
CMS all the default info it needs to properly create your new folder or page including default navigation,
breadcrumbs, styles etc.. Doing it this way is best practice and makes life easier for you!

Tocreate a newpage
● Navigate toSiteRoot, then_Pages

● A page must live inside a folder, so navigate to an existing folder or create a new one (using
Model).

● Once inside the desired folder, navigate to the Model section again.
● ClickStatic Page.
● Name the page, clickCreate.
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The CMS creates a new page and displays it, as shown below.

Toedit an existingpage
● Navigate to the page you want to edit
● Double click page
● Page opens and is ready to be edited

Anote about creating new folders:
When a new folder is created, the folder will contain 2 assets

● _Folder Configuration
● Default

Default will be the landing page for the content stored in that folder. _Folder Configuration will contain
all the configuration settings that apply to just that folder

If you don't see these 2 assets, you didn't use theModel. Delete the folder and try again.
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Editingdefault page
You can edit the folder’s default page like any other page simply by double clickingDefault.

Options for viewingcontent fromEdit View
When a page is opened for editing, Notice buttons in top right,Preview, Inline, andForm. This is how
you will view the content.

● Form (recommended) - gives you access to every data element on the page
● Preview - gives a representation of how it will look on the front end
● Inline - allows you to modify the content on the page, inline with the page. Easy editing!

Basic vs. Advanced layout

Once your page is opened and ready for editing inForm view, you will notice options to edit inBasic
Modeor Layout.
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● Basic Content - used only for simple edits
● Layout (Recommended)

Best practice - even for small edits, it is often better to get in the habit of using the Layout tab where all
the editing functionality is available. Otherwise you are locked into the basic editing capability on that
page.

Here is the recommended approach for editing:
● Open page inForm view.
● Click the Layout tab.
● Select theContent section, then click the arrow next toBasicContent to reveal theAdvanced

Contentoption.
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● ClickAdvancedContent.
● Now go to the top of the screen and clickExpand, as shown below.

● You will see a large grid open as shown below
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● Scroll down to theContent TypeWYSIWYGeditor to begin making simple edits

Pause for a moment to consider what you are seeing on the screen now.

Here I have clicked the down arrow showing the folder structure of where this page lives.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 43



This shows my open page that I am currently editing. In the left navigation pane, the file I have focused
on is highlighted in a blue background. On the right side, the tab corresponding to the page is also
highlighted.

This shows we are inForm view, on theMainContent tab, in Layoutmode, usingAdvancedContent
type.
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AddingRows&Columns
Use the + controls to addRowsorColumnsabove or below the current section you are editing.

Rows show up on the front end as expected.

Columns also require widths to be assigned to resolve on the front end as expected.
● These are the default values for column width for each device type.
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● This is based on the bootstrap 12 column grid.
● Any column count, in a given row, that adds up to >12 will wrap to the next line.
● Below we change bothDesktopColumnWidthandWideDesktopColumnWidth to 50% and

it makes each column take up half of the page.

Publishingpages

Now you are ready to publish your page. These are the controls we will use.
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Steps for publishing your page
1. ClickSave in the top right
2. ClickWorkflow.
3. ClickDeploy toStage.

As the name ‘Stage’ implies, this will publish your page to a place where you can review the changes and
make additional edits, until you are ready to publish to your Live site.

To review this page in Stage, click the box with the arrow, then click the stage site. This will open another
tab and display the page as a consumer on the front end would see the page.

Once you are ready to publish the page to your Live site, clickWorkflowagain. You will see di�erent
options since the page is now in a di�erent stage of its assigned workflow. Select,Deploy to Live.
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Branchingpages

When making changes to a page, it is best practice to first branch the page so the original version is
kept intact until you are ready to replace it with the new version of the page.

To do this we ‘branch’ the original page. Right click on the file. Then clickBranch.
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It makes a copy of the page and leaves it in Draft mode. From here you can open the branched page,
make your changes and publish them to Stage.

When you publish the branched page to Stage, this is what happens:
● If the original page never made it out of the Stage area of the workflow, the CMS automatically

retires the original page, and your new branched page is promoted to Stage.
● If the original page had been published to Live, it would leave the original in Live and your

branched version is promoted to Stage.

When that branched page is promoted to Live, the CMS automatically retires the original page and your
branched version is promoted to Live.

Renamingpages

Warning!Unless a page or folder is still in Draft (never been published), DO NOT ever simply rename a
page or folder by right clicking and selectingRename.

Also, do not rename theDefaultfilename in the left navigation. ‘Default’ is a special name that informs
the CMS that this is the landing page for that particular folder. This is used for building navigation
structures.
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Awordabout renamingpages
Renaming files and folders can be a little tricky in the CMS. Renaming a page is more straightforward
than renaming a folder. Before renaming, consider your end goal for renaming a file or folder and the
available options that will best meet your objectives. Sometimes renaming is not the best option.

Always follow the procedures described in this section to safely rename and avoid unintended
consequences.

Never simply right-click the file and select Rename. Simply renaming a file, does not remove the original
version of the file from the server, which means the original file can still be discoverable in the future. This
can cause your newly named page to fail to render, as expected in the future. All files and folders must
be routed back to draft prior to renaming to avoid unintended consequences from renaming.

There are several pieces of a page/file to consider when renaming a page, each one having its own
procedure.

● Changing the page’s URL
● Changing the File Name (in Page Properties tab) which impacts the saving of future edits
● Changing the Page Name (in Page Properties tab) which impacts how the page name is

displayed in breadcrumbs, navigation links and H1

Procedure to change theURLof apage
It is important to first retire the page to Draft (to remove it from the server) prior to renaming. If the page
is currently in Draft, proceed to step 2.

To rename a page that has advanced past Draft in the workflow:
1. Retire the page to Draft

a. Right click on the file.
b. SelectRoute.
c. SelectDraft.
d. Click theRoute toDraftbutton.

2. Now right click the filename, selectRename.
3. Enter the new name.
4. Republish the page to Stage or Live, as desired

a. [Optional] Consider setting up a redirect since the URL has now been changed.
5. Rename theFileName in Page Properties to match
6. RenamePageName in Page Properties to match

The end result of renaming a Page following the procedure above thru step 4 is that it willonlychange
the URL of the page. You must also change the FileNameandPageName in the Page Properties tab to
match the new URL to avoid unintended consequences in the future. Read through the following
section to better understand why this is important to do as part of the renaming process.

The renamingprocess, explained
Let’s say, for example, I renamePage 1 toPageOneusing the procedure above, stopping at Step 4. If
you then navigate to the page properties tab, it will still show ‘Page 1’ forPageNameandFileNameas
shown below.
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However, the URL is updated to the new name, .../page-one
https://stage-training-ih-ih.cphostaccess.com/admin-guide/demo-folder/page-one
This is indicated in the file view structure on the left (Page One) and the file’s main tab at the top just
under the ‘View’ menu option.

So on the front end, the webpage looks like this:

To finish the renaming process, we have to also update the FileNameandPageName in the Page
Properties tab.

Procedure to renameFileName in PageProperties
It is important to change theFileName so that future edits are not overwritten by the original content.
This is explained later.

To fix the File Name to reflect the new name, you must fix its file title. To do this, you must go into
Properties >Content.
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Search forfile_title and change it fromPage 1 toPageOne.

Now when you go back toPageProperties, it will reflect the new File Name.

However, this still does not change the front end of the website. These elements are controlled by the
PageName in Page Properties.
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To fix this, you must also change thePageName to match the new name.

Procedure to renamePageName in PageProperties
To fixPageName under Page Properties to match the new URL and File Name, simply overwrite the
existing Page Name field with the new name. Now the Page Properties look like this:

Now thePageProperties tab and the left nav name all match and the front end shows as expected.
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Consequencesof not following the renamingprocedure
If you don’t rename theFileName in Page Properties according to the procedure, to match the new
URL, this page will revert back to the original name and last saved content as it existed under that
original name, onceSave is pressed again.

For example, let’s say the original page was namedPage2and we rename it toPage Two.

Prior to the change, the screens look like this:

On front end, URL is https://stage-training-ih-ih.cphostaccess.com/admin-guide/demo2/page-2
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After renaming the page from Page 2 to Page Two, let’s say we do NOT update the Page Properties to
match.

On front end, URL is updated to be:
https://stage-training-ih-ih.cphostaccess.com/admin-guide/demo2/page-two

And the front end of the page still shows ‘Page 2’ the H1, left nav (and breadcrumbs, if enabled) since
‘Page Name’ was not changed.
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Now we go back to the page and make another random edit to the page and clickSave.

In our example, in the WYSIWYG editor, we have original text (‘Here is the original page, Page 2’) that is
striked out and replaced with new text.

After clicking Save, you will see in the left nav of the CMS that ‘Page Two’ reverted back to ‘Page 2’,
indicating the File Name has reverted back to the original name and the URL is back to /page-2.

Redeploy to stage to publish your new changes. Return to Page Properties to see all the current
settings.
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The entire file reverts back to the original version (as seen by the content body missing the last 2 edits).
Why did this happen? Because you didn’t change the filename to match the new URL name.

Technically, the reason the name in the left nav reverts is because it is pulling from ‘file-title’..

File-titleas it is known in Content properties (aka File Name from the properties tab) is not directly
editable from the Page Properties tab.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 57



The only way to change that property and make it ‘stick’ is by editing the file-title through Content
properties as described in the procedure.

If you skip this step, the CMS will look for and find a file with the name stored in ‘file-title’ (i.e. page 2 in
our example) and present that page as it existed the last time it was saved with that name.

The bottom line is, if you don’t update the filename to match the new URL, any edits made under the new
name will be lost once the file is saved the next time.

Alternatives toRenamingFolder
Renaming a folder is more complicated. Renaming folders breaks the navigation inheritance on every
page living within that folder AND in any subfolders below it. If a folder is renamed, all those pages must
have their navigation manually reset.

There are many reasons one may wish to rename a file or folder. If your goal for renaming the page is to
change the URL, consider creating a custom publishing package as an alternative to renaming.
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This is especially beneficial if you have numerous pages whose navigation will be impacted as a result of
changing the folder name. In this case, creating a custom publishing package is the more e�cient way
to achieve the goal of changing the URL. It is a simple change to the publishing path in the publishing
properties section, which changes the URL path name and bypasses the need to manually fix the
navigation on all pages below that folder.

Create a custompublishingpackage tochangeURL
Here you can simply change the publishing path in the publishing properties section, which changes the
URL path name.

Let’s use the following example. Say we have a folder structure of files like this:
Admin Guide/Child that we want the URL to be Admin Guide/Children.

Follow this procedure to change a URL without having to rename the folder:
1. Route all files in that folder (pages, subfolders and pages within subfolders) to Draft. This

removes these assets from the server so they are no longer accessible at that wrong URL, thus
can no longer be accessed in the future.

2. In the left nav, click the folder that should have an alternate URL to highlight it to set focus.
3. ClickPublishingon the right hand side of screen under Properties to create a new custom

publishing package for this folder.

4.From here you can change the URL path name.

5. Notice the folder to which the publishing package will be applied is:
Path: /Core/Clients/CMSServices/Training/Site Root/_Pages/AdminGuide/Child
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Notice the publishing package typically inherits from /_Pages/
This asset currently inherits its publishingproperties from/_Pages/

We want to change the URL from Admin Guide/Child to Admin Guide/Children, To do this:

6. ClickManageHTMLPackages.
a. Next to both stage and live enter /AdminGuide/Children

The starting point for this input value is Root, so put the full path. (using our example
/admin-guide/childrennot /children)

7. Repeat forManageMedia Packages.
8. ClickSave.

Now these new settings now override the original built-in inheritance from the _Pages folder and will
build the URL for pages in this folder’s tree as /admin-guide/children/....

The downside to using the above option is that the left nav still says ‘child’, while the URL says ‘children’.
If you don’t know to look at the publishing package, it may be confusing why the URL is ‘children’ not
‘child’. To change the left nav to match the expected publishing of the URL, you will need to rename the
folder using the instructions below.

Renaming a folder
For this example, let's say I have a folder named ‘Myy Folder’ with pages beneath it that have been
published. Obviously I mis-spelled ‘My’ and wanted to correct the error by renaming the folder.

The problem in renaming a folder is that inherited navigation will break for any pages that exist within
that folder and below, as I will point out in the procedure below.

Prior to making any changes, notice theMyFolder radio button is selected, showing where the page is
inheriting navigation from.
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Procedure for renaming a folder:
1. Route all assets to Draft that exist in that folder and below. (to keep the old URL from being

accessible in the future).
2. Click the folder name, right click, clickRename
3. Enter the new name of the folder - My Folder

4. Route all assets back to Stage or Live.
5. Now go back to theNavigation tab. You will now see the default Navigation is unchecked. So,

this means now all the pages on this level and below will need their navigation rechecked
manually.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 61



This is because what it thinks it has as inheritance, not longer exists (i.e. Myy Folder). This is seen by
navigating toContent Propertiesand searching for ‘inherit’

The downside to doing it this way (renaming a folder) is that for every page that previously existed under
the old folder structure, will now have to be manually rechecked using the radio button for the newly
named folder.

However, any pages created going forward will be fine and automatically inherit the newly named folder
navigation.

Deletingpages

99.99%of the timeyou shouldNOTdelete afile.What you need to do is remove the file from the
server and archive it. Reserve the use of deleting a page to those files that were created inadvertently
and have never been published. Everything else should be handled byRetiringandArchiving.

The only time you ever want to delete a page is if it is in Draft and has NEVER been published before. In
this case it is ok to right click on the file and selectDelete.

For anyother reason, it is best practice to never delete afile or folder.
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Pieces of the file/folder remain at the server level that can cause problems in the future, especially if you
try to reuse the same name.

Rather than deleting, you should use the workflow to advance the file/folder to aRetiredorArchived
state. When you Archive a file, it is removed from view and stays hidden forever from the Active files. To
view Archived files, go to the bottom of the left nav, click the drop down arrow next toActiveand select
Hidden. This will present a new view of the left nav with only the archived files.If after considering the
advice above, you absolutely must delete a file, you must first send it through the workflow to at least
Retired (preferably Archived) prior to deleting to ensure there are no unintended consequences in the
future from deleting the file.

Follow this procedure for deleting Files (pages).Deleting a folder requires a ticket!

Todelete afile/page:
1. Select the file you wish to delete.
2. Route toRetired.
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a. Right click the file.
b. ClickRoute.
c. Click Retired.

3. Route toDeleted.
a. ClickRouteagain.
b. SelectDelete.

Once the file has been deleted, it will be permanently deleted from the system in 2−4 weeks.

Todelete a folder
If you need to delete a folder, please submit a support ticket through the WebMD Ignite Help Center

We have to engage our CMS partner, Crownpeak, to remove files from the server.

When you right click on a file and selectDelete, it does not delete it from the server. It only places the
folder and its contents in the deleted folder. (as opposed to when you send files through the Archive
and Deleted process, that file is actually removed from the server).

Please note: Deleting a file (page) from the server does not delete its parent folder from the server.
When any page is published, its folder is also published to the server. When you use the workflow to
send files through the Archive and Delete process, the file is removed from the server, however, the file
path for the folder will actually remain. If you want that folder to be deleted, you must submit a support
ticket.

Normally the reason this situation presents itself is when a user renames a folder, then they republish all
the pages in that folder, but they did not send all the pages in that folder to Archive before doing so. This
causes the page to be out there at 2 separate URLs.

Additional content

Use theAdditional Content tab to target specific parts of the page for adding additional content.
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Each section in the Additional Content tab, has contextual options that apply.
The default setting for each of these is:

● Inherit FolderConfiguration [Banner orContent] Settings
● Inherit FolderConfigurationContent Settings:Uses content set in the folder configuration. If

the folder configuration is also set to inherit, then site configuration content will be displayed
for this section.

This architecture allows you to configure settings at the page level, folder level or site level.

Pageproperties

Use the Page Properties tab to configure additional details about the page.
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Parent Page
Select a parent page that will be used to build hierarchical data for breadcrumbs and the site map.
The default setting is the Default page of the current folder. Changing this value to manipulate how the
breadcrumbs display. For example, by selecting a di�erent parent page, it will change the
breadcrumbs to reflect the new parent.

PageName
The page name will be used for display in the breadcrumb, default H1 value and the dynamic left/right
page navigation.

Page name inherits from filename.

A good use case for changing the Page Name is when setting up clinical trials pages. A user may want to
keep the filename of the page short, so they create the page using its clinical trial ID as a filename, like
‘CT1234−5’. But they want to use a more descriptive name for the breadcrumbs and H1, so they would
change thePageName from ‘CT1234−5’ to ‘A study of cancer in rats’. Now the left nav in the CMS will
display as CT1234−5 and the left nav, breadcrumbs and H1 on the webpage will display as ‘A study of
cancer in rats’.

FileName
This will be used for the page file name and will be used in the page URL. This field cannot be modified
once the page is saved

HidePage fromSite Search (checkbox)
Check this box to hide the page from the website’s built-in site search. It DOES NOT hide the page from
Google. (Use no index, no follow for that)

OnlyPublish toG2
Checking this box means the asset will only publish to G2. Meaning it will not publish as a regular content
page would and will not have a corresponding URL.
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This is used primarily forAlerts. Alerts are created as regular content pages. We do not, however, want
the alert to display as normal content pages nor do we want it to be discoverable by itself. An Alert’s
purpose is to be consumed by other content pages and displayed as part of the consuming page.
Technically this is achieved by querying the asset using G2 and generally done through custom lists. So,
by checking this box, it enables the CMS to read and display the alert as part of other pages, but it will
not display the alert as a published URL. Since it is not published as a URL the alert content page will not
be discoverable in site search nor will it show up as a stand alone page.

H1
H1 inherits from Page Name, by default. Enter a value here to override the value set in the Page Name
field.

H1CSSClass
Value of the H1 tag’s class attribute. Use this to apply a di�erent style to the H1 content.

HideH1
If an H1 will be added within the body content, check this box to prevent the automatic H1 from
rendering above the body content. This is often checked when using custom content and the H1 is
rendered as part of the custom content widget.

BodyCSSClass
Value of the body tag’s class attribute. This is used to scope CSS to that particular page.

The following are additional sections included in thePageProperties tab.
● Social Media Images
● SEO and Meta
● Page Meta Robots Information
● SiteMap Controls
● Cache Behavior

SocialMedia Images
This section allows you to configure your social media shares with a particular image of your choosing. If
not specified here, Facebook (or other social media platform) will randomly pick an image to display
when the page is shared..

ManagingSEO
The CMS will not leave a page without SEO data, whether it is explicitly provided by the client or not.
Here are the possible ways SEO data is created…

1. The user explicitly provides the SEO data to be used.
a. Provided as theSEOTitlewithin the Page Properties tab (Recommended)

OR
b. Provided as theSEOPrimaryKeywordandSEOSecondaryKeyword in Page

Properties (NOT recommended)

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 67



2. When the user does not explicitly provide SEO data, the CMS programmatically builds SEO
data based on the page name and predefined configuration settings in _Site Configuration >
SEOProperties tab.

3. Content App widgets can optionally be used to override a page’s SEO settings.

SEOfields used fromPageProperties

SEO fields used from_SiteConfiguration
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See each section below for more information on how the CMS generates the data:
● SEO Title
● SEO Title tags display in the Browser tab and on Search Engine Results pages. (SERP).
● SEO Title can be explicitly entered inSEOTitleas shown below.

WhenSEOTitle is provided,SEOPrimaryKeywordandSEOSecondaryKeyword, don’t have any
relevance and are not used in building SEO data. So, just leave them blank.

If a value is provided forSEOTitle, the CMS will generate SEO data as:
● The value provided inSEOTitleplus the domain name
● The string built is

○ [SEO Title] [domain name]
○ example...

Massage Therapy | ABC Wellness Center | ABC Hospital
abchospital.com

If a value is NOT provided forSEOTitle, the CMS will generate SEO data as
● The value ofPageName (in Page Properties) plus other values taken from _Site Configuration >

SEO Properties, as defined in the Smart Title Configuration section
● The exact string built is determined by the configuration settings underSmart Title

Configurationas shown below. These settings are customizable for each client.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 69



● Generally speaking, the string ends up looking something like this
○ [Page Name] [Facility Location-City] [Facility Location-State] [Facility Display Name]

domain name
○ example...

Heart Care Aurora, CO ,
ABC Hospital
abchospital.org

SEOPrimaryKeywordandSEOSecondaryKeyword
Keywords are no longer trackable in today's world like they used to be. So, rather than using these
keyword fields, it is best practice to simply provide a value in SEO Title and leave the rest of the fields in
this section blank. When SEO Title is provided, Primary and Secondary keywords don’t have any
relevance and are ignored by the CMS in terms of building SEO data. If used without SEO Title, SEO data
is built following the Smart Title Configuration section as shown above.

MetaDescription
If meta description is not given in Page Properties, the CMS will grab the first 160 characters of content
in the body content. Otherwise it will use whatever value is entered in this field.

Canonical URL
Providing a canonical URL is a way of telling search engines that a specific URL represents the master
copy of a page. So, If this page is accessed by various URLs, specify here the preferred URL that search
engines should crawl. Providing a canonical URL keeps your site’s SEO strong and prevents your site
from being penalized by search engines for duplicate content.

Another similar use case is if this page’s content is a duplicate of other pages (or even similar), such as a
cardiology page that appears on multiple subsites, you can specify the original source page here. This
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indicates to Google that you know this is duplicate content and the source page Google should use is
listed here.

Meta Tags
We generally do not recommend using this field. However, if you have specific meta tags you want to
push into the site, you can use this field as long as you enter property formed meta tags using valid HTML
markup. Improperly formed meta tags will be output to the HTML and will break the page.

For example, it should look something like:
<meta tag=”keywords” value=”clinical trial, atrial fibrilation, men over 50, Dr. John Smith”>

Do not do it like this:
keywords=’john smith, dave jones, atrial fibrillation’

HideFromSearch
If you want to make 100% sure Google will not find your page, do this…in Page Properties

● Check - Hide from site search
● Select Robots Option - noindex, no follow
● Check - Exclude from XML Sitemap (see below)
● Check - Exclude from Sitemap Page (see below)

Page level controls for hiding
● Page Properties tab > Page Meta Robots Information
● By selecting a Robots Option (no index, no follow etc) from here, the CMS properly configures

the page’s html settings without having to specify this within the Meta Tags section of Page
Properties. Setting it this way reduces the chances of breaking the page by entering improperly
formatted syntax..

Folder level controls for hiding
● You can also control the robots at the folder level.
● Do this by selecting _Folder Configuration for the desired folder > Meta tab > Select Robots

Option

These are the commands that can be given to search engines.
● Index means search engines should show this page in search results..
● Follow means search engines spiders should follow links contained on this page.
● No index means search engines should not show this page in search results.
● No follow means search engines spiders should not follow any links contained on this page for

any purpose.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 71



SiteMapControls

The first option,Check toexclude this page fromXMLSitemap - controls whether the page is included
on the search engine readable sitemap.

The second option,Check toexclude this page fromSitemappage - controls whether the page is
included on the human readable sitemap.

Priority
Set only if you wish to overwrite default settings. 1 would indicate that this is the most important page on
your site. This setting may or may not have any impact either way because Google uses its own search
budget settings in determining how often a site is crawled..

ChangeFrequency
Similar to Priority in terms of real impact to SEO. This is where you would indicate how often the page is
updated. Again, just because you provide this info, doesn’t mean Google will check the page
accordingly.

CacheBehavior
Contact the Services team at WebMD Ignite if you wish to enable CDN and use this feature.

This is related to the CDN. If you have this enabled on your site, you can override the default settings of
caching of your pages,which is usually about 5 minutes, using these controls.
Cache Control Type = private means your site will never be cached.
Alternatively if your web config is set to private and you want this page to be cached, set it to public
here.

Navigation

Use theNavigation tab to configure navigation details about the page.
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By default, both the left and right navigation sections are set to inherit from folder configuration. By
default the CMS will automatically build navigation paths that reflect the file structure. You can further
fine tune these settings with additionalNavigationOptions shown below.

If you want to deviate from the default setting, here are the options, as shown below:
● Display no navigation
● Manually create a navigation for the page

Snippets&Links

Use theSnippets&Links tab to add additional scripts/code to the page.
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This section o�ers the ability to inherit settings from folder configuration with additional snippets
appended, which is useful for controlling behaviors on the page level while maintaining consistency
with other pages.

CustomContent
Custom Content is a CMS feature that allows you to repeatedly use various content templates across
your site in a user-friendly way. Examples of these would be Blog or News pages that you want to have
the same layout for. Another example would be if you want to have various content always output in a
pretty looking card. The following section will show you how to create, configure, and leverage Custom
Content on your site.

CustomContent terms anddefinitions

Below is a list of the various terms and definitions you will come across in this section. This is a very brief
intro to the terms. There will be more detail, further in the guide.

Content Type
A Content Type is the term that describes a created data collection. You can think of your
out-of-the-box data Content Apps, ie. Providers, Locations, and Events, as three di�erent Content
Types or data collections. Each collection then has several entries. Each entry has a defined template of
fields, ie. First Name, Primary Specialty, About Me, etc. In the case of a Custom Content Type, data
entries are called Content Pages, and the fields are called Custom Fields.
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CustomFields
CMS allows you to create Custom Fields that can then be assigned to a Content Type’s Template. This is
done in the Content Type’s _Content Type Configuration.

Template
In the CMS, you can set a list of predefined Custom Fields as a template for your Content Type. This
curated list of fields will be available, whenever a Custom Content Widget or Content Page of a
particular Content Type is created. For example, every time you create a new Provider, you have a given
list, or Template, of fields, ie. First Name, Primary Specialty, About Me, etc.

Content Page
You create a Content Page, just like a Static Page. However, with Content Pages, you will select a
Content Type from a drop down, and then be given a Template of curated fields to populate. Think of
Content Pages as, first and foremost, data entries, which CAN be front end pages, if so desired. The
data from these pages can be pulled and outputted on a Static Page via a Custom List Widget.

CustomContentWidget
A Custom Content Widget is used to create an html representation of a single data entry for a particular
Content Type. No Content Page is needed to build these. They are created using the set field Template
of a Content Type, then outputted using the set Layout for that Content Type.

CustomListWidget
A Custom List Widget is used to create a list of data entries for a particular content type. Content Pages
are required for this kind of widget, as it will search for those pages (or data entries), and output each as
an html structure dictated by a Custom List Layout.

Layout/CustomList Layout
There are two places to set up a Content Type’s layout, which is then reflected in possibly three
di�erent ways. The ‘Layouts’ folder for a particular Content Type is where you set up a Content Type’s
front end Content Page layout, and/or a Content Type’s Custom Content Widget layout. The Custom
List Layout section of Content Apps is where you would set up the html structure for each data entry
outputting in a Custom List Widget. Confused yet? Don’t worry, we’ll go into more detail below.

CreatingCustomContent Types,CustomFields&Layouts

Before you can begin creating Content Pages, Custom Content Widgets, or Custom List Widgets, you
have to first create and configure a Content Type. Here’s how!

CreateCustomContent Type
1. Navigate to your site’s ‘Content Types’ folder: Site Root/_Configuration/_Custom

Content/Content Types.
2. ClickFile >New>CustomContent Type.
3. Name the Content Type and clickCreate.
4. You now have a folder with that new name. Within this folder, by default, you have a ‘_Content

Type Configuration’ file, as well as a ‘Layouts’ folder, containing a ‘Default Layout’ file.
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Create&ConfigureCustomFields
1. Navigate to the ‘Custom Fields’ folder:SiteRoot/_Configuration/_CustomContent/Custom

Fields
2. Click onFile >New>CustomField.
3. Name the Custom Field and clickCreate.
4. Before further configuration, you must first select aField Type from the dropdown menu:

5. Now is a good time to consider what types of fields you want to create and add to your new
Custom Content Type. For example, something like a Blog, would have fields like ‘Story Title’,
‘Publish Date’, ‘Main Copy’, ‘Story Image’, etc. You can create and add (instructions coming up)
as many fields as you think necessary. Following is a list of Field Types and what they are
typically used for:

a. Checkbox - - Used for a simple on/o� toggle option. Example, you could create a
‘Hide Header’ field and update layout to hide/show header, depending on the field
being checked/unchecked.

b. Date - - Used for any date related data. Example, ‘Publish Date’.
c. Dropdown-Multiple Select - - Used to create a list of items that a User can select

more than one item from. Example might be a list of categories that go with a Blog or
News story.

d. Dropdown-Single Select - - Used to create a dropdown that a User can only make
one selection from. Example might be a list of States, and Users can select which State
a story is about or from.

e. Email - - Rarely used, but only allows email format as an entry.
f. Link - - Used to link to image assets, pdf files, other internal pages, etc. Example, a

‘Blog Image’ field would be a Link field type, with Image selected as the ‘Link Type’
(more on that below).

g. Number - - Rarely used, but only allows numbers as an entry.
h. Text - - Very common. This is used for simple text outputs. Example would be a Story

Title.
i. WYSIWYG - - Also common, but is prone to break a layout, as a user is able to add inline

styles, odd html structures, etc. These are harder to account for, when creating a rigid
layout, but sometimes a client wishes for that flexibility.

6. There are various Configuration options available, depending on the type of field:
a. ‘Field Label’and/or ‘Field PopupMessage’ - - All field types have the option to update these.
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b. ‘Required’ checkbox. - - If checked, then it is required to update this field on every Content
Page or Custom Content Widget created that is using this field.

c. List: AvailableOptions - - The ‘Dropdown…’ field types use this configuration option. You can
add new items by clicking on the ‘+’ symbol. There are ‘Label’ and ‘Value’ fields which can, but
don’t have to be, di�erent. Example, say you have a dropdown that lets a user select a color
background. You can have the Label be ‘Blue’, while the Value is a css hex code, ie. ‘#0076CF’.
This allows users, who aren’t familiar with css to easily pick an option, while option will output as
a more usable value for developers.

d. Link Type - - Available on the ‘Link’ field type. This allows you to select from the following
options:

i. Image - - Links to image assets.
ii. Document - - Usually for pdfs, but can be used to link to any document asset.

iii. Audio/Video - - Links to Audio/Video assets.
iv. Other - - Links to internal pages.e.

e. MaximumLength - - For ‘Text’ field types. This will restrict the amount of characters a User can
enter in this field. You can set this, if you don’t want a user creating super long Story Titles, as an
example.

f.Default Value - - You can put a default value in this configuration field. If the user doesn’t manually
update the field in a Content Page or Custom Content Widget, it will output the default value you put
here. Example, a Blog’s Link Text might default to ‘Read More’, unless otherwise specified.

g.FieldWidth/Height - - Only applies to ‘Text’ field types. These two fields only a�ect the UI of the
field template. By default, the field will output as one line, but you can set it to be higher, allowing for
longer text entries to be visible to the user.
7. When you are finished configuring the field, click on the blue ‘Save’ button at top right, then select
‘Publish’ or ‘RePublish’ from the ‘Workflow’ dropdown.

AddCustomFields ToContent Type
1. Once you have created all the necessary fields, you now will need to ‘assign’ them to the

Content Type. Navigate to the Content Type’s ‘_Content Type Configuration’ file: Site
Root/_Configuration/_Custom Content/Content Types/Your New Content Type
Folder/_Content Type Configuration

2. Add field items by clicking on the ‘+’ symbol:
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3. Each item gives you a dropdown, which will allow you to select from any and all available
Custom Fields you may have created in the previous section. The order you list these in will be
the order they will appear to anyone creating a new Content Page or Custom Content Widget.

4. When you are finished adding all necessary fields, click on the blue ‘Save’ button at top right,
then select ‘Publish’ or ‘RePublish’ from the ‘Workflow’ dropdown.

Create Layouts forContent Pages and/orCustomContentWidgets
1. Navigate to the Content Type’s ‘Layouts’ folder:SiteRoot/_Configuration/_Custom

Content/Content Types/YourNewContent TypeFolder/Layouts
2. You may create as many layouts as you like. To create new ones, click on File > New > Custom

Layout. Name your layout and click ‘Create’. There is already a Default Layout for you to
configure, if you only plan on having one layout.

3. Open up the layout file, and you will be faced with a large white editing space labeled ‘Markup’.
There is already a default template available, but you will probably want to erase this and start
from scratch. This space is where you will build your HTML structure. Again, this will be the HTML
for either a:

a. Content Page, in which case, you will be building a layout for a whole page. Example
would be a Blog or News page.

b. CustomContentWidget, in which case, you will be building a small HTML structure.
Example would be a bootstrap card, or something similar.

4. Click theAvailable Tokensdropdown to the right. You will see a list of Tokens that represent the
Custom Fields you had assigned to this particular Content Type in the previous section (There
are also a few out of the box tokens that come with every Content Type, ie. {AssetId}, {Page
Title}, etc. These are at the very bottom of the list). As you build out your HTML, you will copy and
paste these tokens into places where you want the field to output. For example, say you are
building a Blog page layout, and you want the ‘Blog Heading’ field to output as an h1 at the top
of every Blog Content Page you create. Your HTML would look something like this: <h1
class=”blog-heading”>{BlogHeading}</h1>

5. Once you are finished building your layout, click on the blue ‘Save’ button, then ‘Publish’ or
‘RePublish’ from the ‘Workflow’ drop down.

CreateCustomList Layouts forCustomListWidgets
As mentioned above, there is another type of Layout called ‘Custom List Layout’. These are created and
output on a Custom List Widget.

1. Navigate toCustomList Layouts in Content Apps:ContentAppTab>Configurationbox>
CustomList Layouts
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2. Click on ‘Create New’ at the bottom right of the screen.
3. ‘Name’ your layout.
4. Select the ‘Content Type’ that this layout will be used on. As soon as you select one, you will see

a list of tokens populate in the ‘Field Tokens’ area of the ‘Item Layout’ section:
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5. Just like with regular Layouts, you will build your HTML structure here, and use the tokens to the
left. However, in this case you need to, first, click on the source code icon (‘</>’), which allows
you to build using HTML, and, instead of copy and pasting fields, you will drag and drop them in
the spots you want them to output. The naming convention is di�erent from the naming
convention for the Layouts above. Example {BlogHeading} in Layouts, might be
{custom_ss_blog_heading_235476} in Custom List Layouts.

6. The HTML structure you build in the Item Layout section outputs per item found in a Custom List
Widget. Example, say you build a simple bootstrap card layout here, and put in some Blog
tokens. When you build your Custom List Widget, tell it to look for Blog Content Pages, and
output them using this Custom List Layout (more on Custom List Widget creation and
configuration below), it will find all instances of Blog Content Pages (unless filter is set on the
widget), and output each instance as a bootstrap card, with field tokens outputting uniquely
per page instance found.

7. There are also ‘Header Layout’, ‘Item Separator Layout’, and ‘Footer Layout’ sections. These are
rarely used, but basically only output once per widget, or after each item, in the case of the
‘Item Separator Layout’.

CreatingContent Pages,CustomContentWidgets, andCustomListWidgets

Now that we’ve completely created and configured our Content Type(s), it’s time to start utilizing those
e�orts by creating actual content! This means creating Content Pages to be viewed on the front end
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and/or used in Custom List Widgets. Or it means creating Custom Content Widgets or Custom List
Widgets and placing them on Static Pages.

CreateContent Pages
1. Navigate to the _Pages section of your site: Site Root/_Pages
2. You will most likely want to create a Folder named after your Content Type. Some Content

Pages will be used as actual, visitable front end pages and/or as data holders to be outputted in
a Custom List Widget. In this case, just a named Folder is fine, ie. ‘Blogs’. Other Content Pages
will be used only as data holders to be outputted in a Custom List Widget. In this case, you will
want to add an underscore to the name, just to designate it as more of a data folder vs. a
directory that can be visited on the front end. Examples would be ‘_Site Alerts’ or ‘_CTA Boxes’.

3. Once you’ve created a Folder, create a new Content Page within that folder by clicking File >
New > Content Page

Assets

General notes aboutAssets

● Assets have version control
● Most common types of Assets

○ Images
○ Documents (PDFs)

Uploading& replacing images

Touploadan image
1. Navigate to the desired Image folder (or create a new Asset folder)
2. Select File > New > (Model) Asset

3. Drag and drop the image into the Upload box. Then click OK
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Replacing Images
You can replace an image which changes the image to the replaced image but keeps the original asset
ID.

To replace an image:
1. Select the image to be replaced and right click.
2. SelectReplace.

3. Drag and drop the image into the Upload box. Then click OK.
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4. Republish to Stage/Live, as desired.

Note: It is also fine to branch the asset prior to replacing.

Uploading& replacingdocuments

Use the same instructions above for uploading and replacing images, except instead of using ‘Replace’
(images only), use ‘Edit’ as shown below for changing documents.

Documents are handled similarly to images, but there are important di�erences.
● Images use ‘replace’, Documents use ‘edit’.
● Replacing a document (or image) will not change its file name or URL. This has caused confusion

for some because they think by replacing the document, it will update the URL and file name
with the name of the new document. It does not.

For example, a client might want to have a monthly newsletter listed in several places and
named [month] Newsletter. Imagine they upload the one for January first and the url is
established as hospital.com/january-newsletter. Then imagine they add links to that document
throughout the website.
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Then imagine they use the ‘edit’ feature to replace the file contents with february-newsletter. It
will not change the filename in all those places to hospital.com/february-newsletter. The
contents of the file will have the new February content, but the filename will still be
hospital.com/january-newsletter. So in this case it would be best to use a generic name like
current-newsletter if you plan on replacing the content and don’t want to relink the document
throughout the website.

ContentApps
From the Content Apps console, you can manage Providers, Events, Locations, Custom Links, Services,
Taxonomy and Configuration. Each content app has its own menu of management items.

Disabled rows, or records in all ContentApps list views aredimmed for easy identification.

ContentAppsAdministration

Providers
The first step is to create a basic provider record. From there you can Add additional information that
you want to show in the Provider Details section. You can also Edit or Delete the record as desired.

Add, edit, deleteProviders

To addaProvider
1. Navigate toContentApps.
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2. SelectProviders List from the Providers card.

3. Click the+CreateNewbutton to create the provider record.
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4. First name and last name are the only required fields. The rest is optional.
5. Click theSave andContinuebutton.

6. Once the provider record is created, you can click on that provider and enter any additional
data desired.
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Edit Provider
1. Search for a desired provider.
2. Click the name link to open.
3. Edit and fields.
4. Click theSavebutton.

DeleteProvider
Disable keeps the record, but it won’t show up on the site. Deleting the record will remove them from
the database.

To disable a provider:
1. Open provider record.
2. UncheckEnabled.
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3. Click theSavebutton.

To delete a provider:
1. From the provider list, search for the desired provider.

2. Click the check mark to the left of the provider’s name which will present theRemovebutton.

3. Click theRemovebutton.
4. Confirm deletion of record.
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ManageProviderApp settings

These settings are set up as part of an implementation. The client will not have to set them up manually
the first time. However, a client may wish to change these settings.

To access these settings:
● From the Provider list, clickSettings.

● Alternatively you can get to Provider settings from the Provider Card in Content Apps, Click
Settings as shown below.
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CommonProvider settings

SearchResults PageURL - this is the URL where ‘Find A Doc’ search results will display

Default PageSize - the number of results returned per page; up to 25 results can be shown per page;
pagination appears if more than 1 page of results are displayed

Pager Position - this is where the pagination is displayed around the results

ZipCodeSearchRadiusOptions - this allows for a search radius to be applied to the search as shown
below. The values defined here will be used to populate the drop down list box.
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Things to remember about ZipCodeSearchRadiusOptions:
● The values should be listed as one to a row.
● The top value will be the default value.
● If using ‘Any’ list it first, as shown below

Common use case for this:
Client wants the default value to be 10 miles. But allow users the ability to change that to 1, 3 or 5 miles.
Prior to this new feature, clients were limited to 5, 10, 100 and 200 miles.

StandardSearchSort - These settings apply to a result set from a regular (plain) search. It does not
apply to proximity searches. So, for example, if you did a search where the radius was restricted to a
certain number of miles, this setting would not apply to that result set. See Proximity Search Sort for
controlling these searches.

● Alphabetical - returns results in alphabetical order
● Random - returns results in random order
● Provider Group* - returns results in order by Provider Group, then by alphabetical order
● Provider Group* + Random - returns results in order by Provider Group and randomized within

each provider group

* Provider Group sort order is determined by the Provider Group Sort Order as shown below. To see this
click Data > Groups, as shown
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Below you can see the order in which providers will be returned.

So, for example, if Provider Group + Random was selected as the Standard Search Sort, the result set
would display as follows...all providers belonging to PG1 would be randomized and displayed first. Then
providers bellowing to PG2 would be randomized and shown second, and so on.

Proximity SearchSort - this setting controls how results are displayed when searching by Proximity
● Distance - returns results based only by distance
● Provider Group + Distance - returns results in order by Provider Group sort order configuration

and randomized within each provider group

ProximityBasedonPrimary Location (checkbox)
● If enabled, if the provider practices at multiple locations, proximity is calculated exclusively by

the primary location.
● If not enabled, each a�liated location is evaluated independently in search calculation.

SearchResults PrimaryView - options are List or Map
● This setting is usually configured at the widget level

KeywordSearch Fields - use this to include/exclude data that is queried
● When a keyword search is run, the fields in the ‘Include’ section will be searched
● For example, if someone enters University of Alabama and a doctor was educated there and

education was an Included field, they would show in the search results.
● Use the arrows to move data between Include and Exclude.
● The term ‘keyword’ can also be used here. This can refer to the taxonomy used by the site as well

as the custom keywords that can be associated with a provider
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Site Search Fields - this functions the same as Keyword Search field, but relates to site search (as
opposed to Find a Doc search).

Detail Settings - these are all setup as part of the client’s new site configuration.
It is strongly recommended to NOT change any of these settings.

Detail PageURL - this is where provider details page will be outputted

DirectURLPath - this is the root path for the doctor URL; it is created based on the tokens selected

DirectURL Formula - this determines how the URL is dynamically created for each doctor

Default Provider ImageURL - this is used to override the default image settings

ManageProvider SEOsettings

These settings are also set up initially for the client during implementation and should NOT be changed
without first consulting with a WebMD Ignite support engineer.

These SEO settings are token based and for content apps will override the system settings.

When configuring a content app widget that has a List ViewandDetail View you often get settings like:
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It varies from widget to widget, and view to view, but this is the idea.

These takeprecedenceoverwhat's definedat thepage level. The values for these can also be set
specifically on a provider/event/location record, or in the absence of a specific value it falls back on a
formula for providers, the default formulas are defined in the Provider Settings area of the content apps
admin:
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Detail Page Title Formula - this is completely configurable using tokens and text to create a SEO setting
for doctor detail pages.

Detail PageDescription Formula - if an ‘About me’ section exists we will use this for the meta
description. Otherwise, we pull in first 160 characters

Other options where SEO can be specifically configured for Content Apps includes:
● Search Results Page Keyword Formula
● Search Results Page Name Formula
● Search Results Page Specialty Formula
● Search Results Page Base Formula

ProviderNameSettings - this is used to configure the ‘provider name’ token that is used on the Details
widget; when you drag over the token for provider name this is where that token got
configured/constructed from those fields in the provider record.

AdminSettings /UseAutocomplete forDropdowns (checkbox) - Enables autocomplete for
specialties and conditions, locations and clinical interests dropdowns in provider record, as shown
here. If not checked, it uses a dropdown list instead.
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Need to add information about reporting here.

Locations
The Locations Content App allows consumers to search for locations that are associated with the
healthcare organization. From the screens in this app, associated content, such as: Location Types,
Insurance and Services can be customized, based on your preferences.

Howtoaccess the LocationsContentApp

To access the Locations Content App from anywhere within CMS Admin, click the Content Apps
(WebMD Ignite icon) option from the left navigation menu. Click on the Locations List option in the
Locations square. All of the remaining links from this panel (Types, Insurances, Services and Settings)
are accessible from within its pages.

Add, edit, delete Locations

To adda location:
1. Navigate toContentApps.
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2. Select the Locationscard.

3. Click the Locations list.
Note:Accessing locations links other than Locations list is as simple as expanding the Data
dropdown or clicking through to the Settings or Reports menu items once you’ve clicked
through to Locations list:
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4. ClickCreateNew+.

5. Enter the name and other pertinent information. Once you enter the name, that’s really enough to
save the location record, but it’s best to be as thorough as possible.
6. Click theSave andContinuebutton.
7. You’ll now see a left-hand navigation bar on your location instance. It should looks something like this:

8. Complete all desired fields and click theSave andReturn to Listbutton when done.

Important notes about Locations details:
● AddressSection

The Address fields are used to run a geocode through Google Maps. If your Google Maps API
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key is associated with your instance, the CMS will automatically calculate and apply the latitude
and longitude based on the address given.

● CustomCoordinates - The Google Maps location marker can be overridden by using ‘Custom
Coordinates’. For example, if the parking lot was at a di�erent location than the building
address, you could use this to point users to the parking location.

● Contact info (Phone, Fax and Email)
This will be inherited down to the providers associated with this location, however, that
inheritance can be broken at the Provider level.

● Events&Payments - see notes
Potential Event Location - Important to check if you are planning to create an event that should
be tied to this location.

● PaymentGateway - this also should be selected if you plan on having paid events. This setting
is used to tell the CMS which gateway to use to process payments for events.

● MiscSetting - see notes
You can toggle on/o� the following setting to control how the location can be found

○ HIde from Site Search
○ Hide from Location Search
○ Hide from Provider Display

For example, if you want to associate a provider to a location for site context but don’t
want that location to show in the physician's profile, you toggle o� the ‘Hide from
Provider Display’ setting.

○ Service LineURL -Donot use - this functionality hasbeendeprecated.
● SEOSettings - see Manage SEO Settings
● CustomFields - see notes

Custom Fields are used to create custom data points. Use this section if no other fields fit your
needs for displaying data on the front end or including it in search. Please note, this isn’t used
much anymore. Now dynamic columns have generally replaced the need to use these fields.

Upon saving a location’s basic information record, you can add the following types of
information if it exists for that location by clicking on the section header

In the left-hand nav example, you’ll see some of the following items: dynamic columns , hours, services,
insurances, location types, site association, taxonomy, direct URL history, and data integration.

● DynamicColumnsare created specifically for you and your health system’s needs. No two sites
are alike.
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● Hours - Enter discrete fields or a custom message, per day.

● Services - Choose existing services or create a new one
○ This is one way to add a list of services to your location details page

● Insurances
○ Like Services, this is also not really used much anymore. Since insurance is determined

by both location and provider, most clients don’t use this location based feature.
○ If you want to associate an insurance to a location, you would do it here by selecting an

existing insurance or adding a new one.
○ To see a list of insurances click Data in top left of the screen, then select Insurances
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List of Insurances

● Location Types -use this section to add location types such as hospital, emergency, urgent
care etc
To see a list of location types, click ‘Data’ in the top left. Then select ‘Location types’.

Location types are helpful when powering searches and populating widgets throughout the
site.
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● SiteAssociation
○ This is an advanced topic.Please do not edit these settings without first touching base

with your web engagement lead or reaching out to the WebMD Ignite support team.
○ Site Association allows you to partition out the providers and events that will show up

on a given site.
○ This is used primarily with subsites, where the subsites have their own providers and

events.
○ This will establish a relationship with a URL and the providers and events that are

associated with that URL.
○ So in this example, Public Domain URL is www.acme.com/acme-medical-center

Assume acme-medical-center is a subsite. What this will do is limit search results
(provider, location or event search) on this subsite to only doctors and events that are
associated with this location or any children locations underneath this location.

○ The remaining fields on this screen are used to provide corresponding urls so the site
association context works on all the urls for both pre and post go-live.
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● Taxonomy - this section allows you to assign taxonomy terms per location
○ CustomKeywords - this might be used when a location name has changed or been

rebranded and the former name no longer exists in the content. You would enter the
former name here so that location and site search searches will return this location
when that former term is searched on.

● DirectURLHistory
○ For example, the direct URL for a site might be acme-medical-center but the customer

wants to override this setting, they would do that by checking ‘Custom Direct URL’ and
providing a new ‘Direct URL’ like acme-medical-center-and-health-facility

● Data Integration

The main purpose of the Locations List, Location Types, Insurances (and to a lesser extent, Services) as
seen in the Data drop down menu, is so they can be searched on.

Manage LocationContentApp settings

LocationSearchSettings
You should never have to edit these settings. Search functionality of most sites is powered by widgets
which o�er much more advanced and robust search filtering and presenting capabilities. If you want to
adjust how your results are presented, please reach out to your web engagement lead or the WebMD
Ignite support team to be sure you’re going to the right place.
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Note: If you are not seeing a location or changes present in results, click the Refresh Site Search Index
button in the screenshot above.

LocationDetails settings
Editing anything in this section is not recommended without the guidance from your web engagement
lead or the WebMD Ignite Support Team.

LocationSEOsettings
As with providers, the SEO settings are configured by WebMD Ignite as part of the implementation.
However, a user can use these settings to override the system default settings.

ClickSettingsand toggle open the SEO settings accordion:
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The other SEO settings that can be configured per location are
● SEO Page Title
● SEO Page Description
● SEO H1
● SEO Primary Keyword
● SEO Secondary Keyword
● SEO Canonical URL

You will see all of the standard options to pull into your meta information, however, you can also
free-hand text into these fields. Please be mindful that anything free-typed will be shared across all
locations on your website and you’ll want to be mindful of character limit best practices.

Location InheritanceSettings

Location LeadManagement Settings
In the Location Settings you’ll see these two options as well. Please do not edit them without guidance
from WebMD Ignite .

LocationsReporting

Locations reports allow for the ability to define, run, and export Locations reports. This link exists with
the Locations tile on the Content Apps admin landing page.

Here, over 30 location fields can be referenced by report criteria and displayed by the resulting report.
All dynamic columns are also able to be queried here.

If you haven’t already created reports, click on New Report to create your first:
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The reports tool has been set up to be “wizard” style.

Name your report something appropriate:

Drag the fields you want to have in your report from the Available Fields column to the Report Fields
column:
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If this is a report you’ll run many times in the future for di�erent reasons, click Save before adding in your
conditions for query.

Add your conditions for your locations query:

ClickNext Step.

Events
The Events Content App allows consumers and patients to search, register, and pay for events that are
associated with your organization.

To access Content App components from anywhere within CMS, click the Content Apps icon from the
CMS left menu.
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Then click on one of the options in the Events box to access the Events content apps:

● Events listwill take you to the list of all events - current or past where you can search for or filter
for specific events.

● Events topicswill take you to a list of the topics that have been created for your events (i.e.,
childbirth, weight loss, etc.)

● Event typeswill take you to the list of the event types (i.e., seminar, virtual class, etc.)
● Registrant searchwill take you to a comprehensive list of all individuals who have registered for

events on your site. Here you can search for registrants.
● Registration forms takes you to where you can edit or create registration forms to use when

patients/consumers are registered for specific events
● Discount codesallows you to create or edit discount codes that can be applied to events of

your choosing
● Reports lets you run reports of events, registrants, and a whole host of options based upon

specific queries you create. Reports are downloadable and schedulable.
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● Settings allows you to update the automated SEO settings, refresh the site search index, etc.
You likely won’t have to access settings very often.

EventsModuleNavigationOptions

Available tabs are listed below.:
● Home (Click this tab to return to the Content Apps console.)
● Data (Eventsopens to this tab, by default.)
● Settings
● Reports

Event List – FilteredSearch

From theHome tab page, you can perform a filtered search by category, narrowing your search results,
as you make selections from the following:

● ID (number entry)
● Keyword (free-text entry)
● Location (drop-down, listing your hospital locations)
● CreateDate (date picker)
● PublishDate (date picker)
● Start Date (date picker)
● Event Topic (drop-down, listing topics such as: ACLS CPR NRP COURSES, ACLS Topic,

Bariatrics Weight Loss Surgery, Bone Health, Cancer, Cancer Support Groups to Transplant
Organ, Weight Management, Wellness Programs, Women’s Health Education)

● Event Type (drop-down, listing topics such as: Childbirth Education, Class, Fair or Health Fair,
Free, Health Education, Online Class, Online Gift Shop, Screening, Seminar and Webinar)

● Status (drop-down, options are: All, Enabled, Disabled)

Search for anEvent record byKeyword,CreateDate, PublishDate, Event Topic (drop down list),Event
Type, Status (All, Enabled, Disabled) or Location), with options toApply (run the filter based on your
selections), or toClear Filter.

● ID (This field is generated by the system on creation of a new event.)
● Title (This is the title of the event.)
● SummaryDescription (This is the description of the event that was entered on creation.)
● Location (This is the location where the event will be held.)
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● CreatedDate (This is the date the event record was created.)
● PublishDate (This is the date the event record was updated.)
● Actions (Applicable to the selected record, or row, these are:Edit, CopyEventorCopyEvent

andOccurrence.)

If an event is disabled, it will still appear in the list, but the content row will show as grayed out.

Using thecolumn sortingoptions
There are filtering options for each column, or sortable field of the record. Sort Ascending, Sort
Descending and Hide Column. Once a column has been sorted, theRemoveSortoption becomes
available.

There are filtering options for each column, or sortable field of the record. Sort Ascending, Sort
DescendingandHideColumn. Once a column has been sorted, the Remove Sort option becomes
available.

Unhiding a hiddencolumn
To unhide a hidden column, refresh the page to reset the grid.

Using theActionsbuttons
Under theActionscolumn are additional options that are applicable to a selected record, or row:Edit,
CopyEventorCopyEvent andOccurrence.

To select a record to perform an action on, use the checkbox button to the left of the record, then
select the desiredActionsoption.
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Add, edit, delete Events

AddingEvents
To add an event, you will want to access theEvents list.

In the bottom right-hand corner, clickCreateNew:

Event addition is built to wizard-style, so it walks you through the whole setup process. Red asterisked
fields are required.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 111



Note: in order for an event to be active, it has to be enabled, have a publish date set in the past, and
have at least one active occurrence.

Enter the Content fields as prompted:
● Title: Enter the title of the event.
● Description: Enter a description of the event. There are no character limits here, but you may

want to check with how the events look live on your site and mark down a number that works so
that your events have some consistency to them.

● Event Type: Choose an event type from the drop-down options, such as: Childbirth Education,
Class, Fair or Health Fair, Free, Health Education, Online Class, Screening, Seminar, Webinar. You
can add additional event types <link to section on adding event types>, if needed.

● Event Topic: Choose an event topic from the drop-down options, such as: Bariatrics Weight
Loss Surgery, Bone Health, Cancer, Cancer Support Groups, Community Classes, Continuing
Education, Diabetes Programs, Employee Education, etc. You can add additional event topics
<link to section on adding event topics>, if needed.

● Presenter: Enter the name of the presenter for the event. Note: this field is not required.
● Attachments:Click the Add button, then the Upload button to browse for single or multiple

files to upload and associate to this event. The file size maximum is 50MB.

Note:You may see additional fields in your instance. Not all content apps setups are the same. You will
have to outline for your team any specifics around fields that are unique to your organization.

ClickNextwhen done to access the Locations details.
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Choose the appropriate location from the dropdown. This will be populated by events that have been
marked as Event Locations in the Locations content app. Location must be populated in order to
continue adding a new event.

If, however, the event location does not exist in your content apps, you can click the Custom Location
checkbox. You will then be presented with a whole list of new fields to enter the location information

Choose whether or not the event is aSingle Event,OpenEvent, orRecurring Event.

Complete the event date and time information and clickNext Step to continue to the Registration
screen.
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● Cost: If there is a fee to attend your event, you will want to add that in the Cost field.
● MaximumAttendees: Enter the maximum number of attendees (including guests) for each

occurrence of this event. Can be overridden at the occurrence level.)
● EnableGuest Registrants: If this checkbox is enabled, additional guest registrants can be

added during registration.
● RequireGuestDemographics: Clicking this box adds guest information fields for users to

complete when registering for a class for a friend or family member.
● Waitlist Enabled: Checking this box allows for enrolling in a waitlist when the maximum number

of attendees has been reached.Note: Supporting functionality and messaging must be
enabled on the event widgets e.g. Details, Checkout, Confirmation etc.

● DiscountsCodes: Use the available Add button to add any discount codes that can be applied
to the cost of the event.

● AllowSelf-Cancellation: Checking this box allows event registrants to cancel their own event
registration using a cancellation link in their registration confirmation email.

● Automatic Refunds: Check this box to allow for automatic refunds of the registration costs for
paid events when a registration is canceled.

Note:You may see additional fields in your instance. Not all content apps setups are the same. You will
have to outline for your team any specifics around fields that are unique to your organization.

ClickNext Steps to move onto theQuestions screen:

Click the+Addbutton to add a question, and you’ll be presented with the following fields:
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● Question Type:
○ QualifyingQuestions: Add qualifying Yes/No questions that are presented before a

user can complete registration. These questions require a “Yes” answer in order for the
patient to complete registration.

○ SurveyQuestions: These questions are presented to the user during registration and
can be marked as optional. Choose between text, date, or dropdown. If you choose
dropdown, you will be presented with additional fields to complete to present the
options to your users.

● QuestionOrder: Allows you to choose the order in which your questions appear to users.
● Question: Enter the question for your users here.
● UnqualifiedMessage: When a user answers with a question that disqualifies them from

completing registration, this is the message they’ll receive.

If you don’t want to add any qualifying questions or survey questions, you can clickNext Step to
proceed to theContact screen:

● ContactName: Enter a contact name for the event in this free-text field.
● Contact Phone: Enter the contact phone number in the format it will be displayed.
● PhoneExtension: Enter a phone extension for the contact phone number, if applicable.
● Contact Email: Enter the event contact’s email address i  n the correct format, separating

multiple email addresses with semicolons.

Click Next Step to move onto the Review & Publish screen:
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Here you’ll be presented with a Publish Date (required) and Unpublish Date (optional) field. Below this,
you will see all of the other information you have completed during the event set up. If you’re satisfied
and have completed your Publish Date field, click Save Event in the lower right hand corner.

Once you clickSave, your view of the events entry will change, and you’ll be presented with a new
screen that now has left-hand navigation. This is, essentially, all of the fields you completed during
event entry broken down into tabs, with a few additional options added in.

On this screen, you can now upload a new image. Hover over the calendar icon in the upper left corner
and you’ll see an option toUploadorBrowse. Choose Upload and follow the steps presented to you to
add a photo. ClickSavewhen you’re done.
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Other new options you’ll have available to you include: Dynamic Columns, Content, Occurrences,
Registration Forms, Email Templates, Taxonomy, and Direct URL History.

● DynamicColumns: Dynamic Columns are created on a site-by-site level based on your
organization’s needs.You will have to outline your dynamic columns internally to ensure
consistency for event administrators.

● Content: This WYSIWYG allows you to add more content about the event. Where and how it
presents on your site, is dependent upon how your site was built. You will have to notate
internally specifics regarding this field to ensure consistency for events.

● Occurrences: Recall that you must have an active occurrence in your event instance in order for
it to be present on your site. This should automatically populate based on the information you
added during event creation, but you can always check this tab to make sure you see the
occurrences you would expect to see.

● Registration Forms: You can choose specific registration forms from this section. Click the Add
button in the upper right to choose from available registration form templates. This is helpful
when you have classes that require specific information (like due date for childbirth classes)
that not all events will require.

● Email Templates: Choose from available emails for event registration, reminder and
cancellation.

● Taxonomy: Add taxonomy <link to taxonomy section> to your events to make them more
searchable. Note: taxonomy has to be added to your site first. Or you can add individual words
to the “custom keywords” section. Separate keywords by commas.

● DirectURLHistory: This tab gives you a history of any URL changes that have occurred with your
event. This may be an empty tab if no URL changes have occurred.

● Notification andRoster Request Emails: Under “Contacts & Notifications” you will see two
additional fields and a checkbox for “Send Notifications” If you would like to add additional
email addresses to receive Roster Notifications or generate roster requests on demand, those
emails may be entered here.
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Editing Events
If you need to edit an event, navigate to theEventsContentApp.

To access Content App components from anywhere within CMS, click the Content Apps icon from the
CMS left menu.

To edit an event, you will want to access the events list.

Use the search options and filters at the top of the events list to find the event you need to edit:
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Navigate to the field(s) that needs editing, make your edits, and clickSave.

Editingoverview
Tabs on the left allow you to update the Edit screen by category.

● Basic Information
● Content
● Event Topics
● Event Types
● Taxonomy
● Discounts
● Prerequisites
● Occurrences
● Registration Form
● Email Templates
● Direct URL History

Basic Information
Basic Informationfields control the parent-level data for your event. Some inputs will carry forward to
new occurrences as they are created. A checkmark beside the field on the right indicates that the field
is required. They are as follows:

● ID (This is system-generated when the event is created.)
● External ID (If an external ID exists, it will display here. External IDs are created if COD10 is

importing events from an external data source through a data integration via the API)
● Enabled (Enable/deactivate the event using this checkbox. This field must be enabled for an

event to be indexed and found in site search and event search.)
● Title (This is the event title.)
● Description (Enter the description of the event.)
● Special Instructions (Enter any special instructions for the event)
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● PublishDate (Begin typing in this date field to enter the publish date. The calendar widget
displays for formatted selection. This field must be completed in order for this event to appear
in the search filter options.) (ü)

● UnpublishDate (Begin typing in this date field to enter the unpublish date. The calendar widget
displays for formatted selection. Your event content will be removed from display on this date.)

● Cost (If the event is paid, you can enter the cost here as a number. This value will be inherited by
any new occurrences that are created)

● MaximumAttendees (If an event has a cap on attendees, enter the total number of registrants
as a number. Leave blank if there is no cap i.e. unlimited)

● EnableGuest Registrants (Check if you want to allow users to register themselves as well as
others)

● RequireGuestDemographics (Check if you want to capture additional demographic
information e.g. email, street address etc. for guest registrants)

● Location (Select the location of the event. This value will be inherited by occurrences created)
● CostCenter (If a cost center, as defined by your finance\accounting department, exists for

payment reconciliation, enter it here)
● BusinessUnit (Tier 3) (This field is tied to an old application that is being sunsetted as of this

writing. It can be ignored)
● ContactName (Enter a contact name in this free-text field.)
● Contact Phone (Enter this information in contiguous numbers. The field auto-formats as a

dash-delineated phone number, for example: 800−555−5555.)
● Extension (Enter the phone extension number, where applicable.)
● Contact Emails (Enter the contact emails for the event in email format. This input is associated

with the event details widget token for contact email.)
● SendNotifications (Check this box to notify contacts.)
● Notification Emails (Enter one or more emails separated by a semicolon to receive notifications

of new registrations, cancellations etc.)
● Roster Request Emails (Enter one or more emails separated by a semicolon that are authorized

to request rosters for a given event\occurrence via the roster request widget)
● SendReminder Emails (Select the days prior to an occurrence where registrants will receive a

reminder email)
● CustomDirectURL (Check this box if you wish to override the auto-generated direct URL
● DirectURL (If Custom Direct URL is checked, you can enter the direct URL here)
● CustomKeywords (These are keywords that will be associated with the event and will be

indexed for event search purposes.)
● E�ectiveKeywords (These are non-editable system-generated keywords that are related to

the event and are used for event search purposes.)
● SEOPage Title (This is found in the <head> element. Title tags are often used on Search Engine

Results Pages (SERPs) to display preview snippets for a given page and are important both for
SEO and social sharing.

● SEOPageDescription (Also found in the <head> element, this describes what a page is about
in 150 characters or less. In search results, this returns as the main descriptive text.)

● SEOCustomMeta Tags (Use custom <meta> tags to provide search engines with additional
information about your pages. Search engines use this information to create rich snippets or
enable sorting of search results.)

● SEOH1 (This heading 1 tag element is used near the top of the page as the page version of the
page title, or to describe the page's content and is important for optimal SEO.)

● SEOPrimaryKeyword (The primary keyword is the one searched most frequently.)
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● SEOSecondaryKeyword (The secondary keyword is the one searched the second-most
frequently.)

● SEOCanonical URL (The tag attribute bears similarity to a 301 redirect, but it communicates to
search engines that multiple pages should be considered as one, without actually redirecting
visitors to the new URL, so that you can still track visitors separately to unique URL versions, such
as: Payment Gateway (PayFlow Pro, Authorize.net). The term, canonical, refers to conforming to
an accepted rule or procedure.)

● Hide fromSite Search (Check this box to hide event from site search results)
● Hide fromEvent Search (Check this box to hide event from event search results)
● CustomField 1−3 (Add your Custom Field content.)

Note: Choose Cancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. Choose Save and Return to the List to
commit your changes and return to the list page.

DynamicColumns
Custom inputs created as dynamic columns assigned to the top-level event record can be edited in this
tab. Dynamic columns for your instance will be unique.

Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Content
Separate from the description, the content tab contains a WYSIWYG editor which allows for the full
description and content surrounding the event to be maintained. This is displayed via a token in the
event details widget.

Note:ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Attachments
Any documents associated with an event (e.g. study guides, calorie counter etc) can be uploaded and
stored as part of the event record. Links to the attachments are displayed via a token in the event
details widget.

On the attachments tab, click “CreateNew” in the top right corner.
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ClickUploadand select the file you wish to upload as an attachment. Then click ‘Save’ upload and
attach the document to the event.

Once uploaded, you can edit the file name displayed in the event details widget. By default, the file
name will show as the display name. After entering a new display name, click “Save”

Note:ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.
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Event Topics
The event creation wizard requires and allows for only one topic to be assigned to an event during initial
setup. Once created you can assign additional topics to an event.

Click the event topics tab and then select eitherAddExistingorCreateNew.

IfAddExisting is selected, a modal window of available topics will appear. You can add a single topic or
multiple topics. Select the topic(s) you wish to add then clickAddEvent Topics

If you need to create a new topic, click +CreateNew a textbox will appear where the new topic should
be entered.

Note: Topics created here will be added to the global list of event topics and will be available for use by
other events.

You can remove event topics by clicking Delete next to the topic to be deleted.

Note:ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Event Types
The event creation wizard requires and allows for only one type to be assigned to an event during initial
setup. Once created you can assign additional type(s) to an event.

Click the event types tab and then select eitherAddExistingorCreateNew.

If Add Existing is selected, a modal window of available types will appear. You can add a single type or
multiple types. Select the type(s) you wish to add then clickAddEvent Types
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If you need to create a new type, click+CreateNewa textbox will appear where the new type should be
entered.

Note: Types created here will be added to the global list of event types and will be available for use by
other events.

You can remove event types by clickingDeletenext to the types to be deleted.

Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Discounts
In order for a registrant to use a discount code on an event, that code must be assigned to a given
event. This allows for common codes to be used across events as needed without having to create
individual discounts for each event.

Click theDiscounts tab then selectAddExisting. A dropdown of available discounts will appear. Select
the one you wish to add then click+Add. Repeat these steps for any additional discounts you would like
to add.

You can remove discounts by clickingDeletenext to the discount to be deleted.

Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.
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Prerequisites
If a user is required to complete a prerequisite class e.g. an “intro to..” class or “Level I” prior to taking
another class you can create an association between the two events. This allows prerequisites to be
listed on the event details page.

Note: COD10 does not o�er validation that a user has successfully completed a prerequisite class
during the registration process. It only lists the classes flagged as a prerequisite for a given class.

Click thePrerequisites tab then selectAddExisting. A list of all classes in content apps will be
displayed. Select the one you wish to add then click+Add. Repeat these steps for any additional
classes you would like to add as a prerequisite.

Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Occurrences
See the managing occurrences section in this document.

RegistrationQuestions
Registration questions consist of two types of questions:QualifyingandSurvey. Qualifying questions
require a user to answer “Yes” before proceeding to the registration for an event. They can be used to
screen registrants that may not meet certain criteria for an event e.g. minimum age, vaccination status,
planned birth at a given hospital etc. Survey questions are added to the registration form as free text
entry fields. (Note: Free text entry was built to accommodate data integration with external systems that
do not support structured data inputs such as a date, select, number. If you don’t require integration
with a third party with these restrictions, it is advised to use the registration forms functionality to
capture additional data from registrants)

QualifyingQuestions
Click on theRegistrationQuestions tab and click+CreateNew. SelectQualifying from the Question
Type dropdown menu. If you have multiple qualifying questions, enter a number for theOrder in which
you want the qualifying questions to appear as each question will display in the order defined. Enter the
text of the question in theQuestion input. In theUnqualifiedMessage input, enter the text you wish to
display should a registrant answer “No” to a qualifying question.
To add additional qualifying questions repeat the steps above, making sure to set the order of
qualifying questions by incrementing the number in theOrder input.

SurveyQuestions
Click on theRegistrationQuestions tab and click+CreateNew. SelectSurvey from the question type
dropdown menu. If you have multiple survey questions, enter a number for theOrder in which you want
them to appear. (All survey questions appear on the registration form, this number defines the order
from top to bottom in which they appear.) Enter the text of the question in theQuestion input.

To add additional survey questions repeat the steps above, making sure to set the order of survey
questions by incrementing the number in theOrder input.
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Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Registration Forms
Click theRegistration Forms tab and click+AddExisting. Select the registration form you would like to
add to the event from the dropdown menu then click+Add.

Note: Instructions on creating a registration form are available in theCreating andEditingRegistration
Forms section of this document.

Note:ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

Email Templates
To select which confirmation, reminder and cancellation (if applicable) emails are sent to registrants
click theEmail Templates tab.

Note:Events will use the default email template, changes to this area are only necessary if you would
like to send emails using another template or create a custom email ad hoc template for an event.
Under each of the three headings, select a new template from the TemplateNamedropdown menu.

IfCustom is selected, a window will appear allowing you to customize the template in the same way you
would create a new template. The di�erence being that this customization will not be saved as a new
template available for use on other events.

The process for creating a custom template on an individual event is the same as creating a shared
email template. See the Creating Email Templates section of this document for instruction.

Note:ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save to commit your changes and remain in the edit screen. ChooseSave andReturn to the List to
commit your changes and return to the list page.

The TaxonomyTab-Events
Associate terms from the taxonomy hierarchy to individual events, using the Taxonomy tab in theEvent
Edit Screen. In the TaxonomyTermsfield, begin typing any taxonomy term from the hierarchy and the
list will expand with all available options, beginning with the letters you enter.

Select a taxonomy term from the list. In the example below, we chose Heart and Heart Condition. Click
Save. TheE�ectiveKeywordsfield expands to include Heart and Heart Condition, plus all child terms.

CustomKeywords andExcludedKeywords fields have been moved to this tab as well, as they are
interrelated. These fields function as previously. You can still add custom keywords and exclude
specific keywords to form this finalE�ectiveKeywords list for the event record.

Deleting Events
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If you need to delete an event, navigate to the Events Content App. Keep in mind that if you delete an
event, you will lose any information associated with the event. It may make the most sense to disable or
unpublish the event instead of deleting it.

To access Content App components from anywhere within CMS, click the Content Apps icon from the
CMS left menu.

To delete an event, you will want to access theEvents List.

Use the search options and filters at the top of the events list to find the event you need to delete:

Once you have the resulting events based on your queries in the previous step, click on the checkmark
to the left of the event name and then click theRemovebutton in the bottom right of the screen..
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EventOccurrences

To accessOccurrences, go toContentApps>Events (Events List in the defaultData tab). Select an
event to edit by clicking the eventNameor by clicking theEdit (pencil) icon. When theEdit screen
opens, in the left panel, choose theOccurrences tab. ActiveOccurrencesdisplay here. From this
screen you can manage an existing occurrence or create a new occurrence.

Create newoccurrence
Click theCreateNewbutton to create a new event occurrence. You will be presented with a screen
with the following fields. Required fields are noted in red.

● Enabled (Check this box to enable display of the occurrence.)
● Presenter (This field holds the name of the event occurrence presenter.)
● Special Instructions (Click the Show/Hide button to reveal a content WYSIWYG editor that

allows you to format your message as users will view it.)
● Location* (By default, the occurrence will inherit from its parent event.)
● CustomLocation (Check this box to indicate this as a custom location.)
● CustomName (This field enables if the Custom Location checkbox is enabled. Enter the name

of the location here, if applicable.)
● Address Line 1 (Enter address line 1 of location.)
● Address Line 2 (Enter address line 2 of location, for example: Suite 100.)
● City (Enter the city of the location.)
● State (Enter the state of the location.)
● Postal Code (Enter the ZIP code of the location.)
● Latitude (Read-only, unless enabled by the geocode this address button. Enter the latitude of

the location. Latitude is the angular distance of a place north or south of the earth's equator,
usually expressed in degrees, for example: 51° N. To find the latitude and longitude of a
location, use a latitude and longitude finder such as Google Maps.)

● Longitude (Read-only, unless enabled by the geocode this address button. Enter the
longitude of the location. Longitude is the angular distance of a place west or east of the
earth's equator, usually expressed in degrees, for example: 20° E.)

● CostCenter (If using PayflowPro or Authorize.net, enter the name of the department or other
type of unit within your organization to which costs may be charged, for accounting purposes.)
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● StandardCost (Enter the price of admission in this free-text field.)
● AllowPayOnsite - Allow users to register for a paid event without entering CC info. This feature

will only be available if the Cart contains pay onsite events exclusively
● Automatic Refunds - If using the Tempus payment gateway, COD10 can automatically issue

refunds to the card used if self-cancellation is enabled.
● Registration Enabled (Check this box to enable registration for your event.)
● RegistrationOpenDate (Enter the event occurrence registration open date, using the calendar

widget that displays when you click the field. The date format is mm/dd/yyyy.)
● RegistrationCloseDate (Enter the event occurrence registration close date, using the calendar

widget that displays when you click the field. The date format is mm/dd/yyyy.)
● MaximumAttendees (Enter a number in this field by which to restrict the number of attendees.)
● MaximumGuestAttendees (Specify the maximum number of guests, or additional registrants

for this event occurrence. If the maximum number of additional registrants is reached, the Add
Additional Registrants button disables for the registrant, with a displayed message, stating that
the maximum number of additional registrants has been reached.)

● RequireGuestDemographic Info (Check this box to include guest demographic information.)
● Availability (Seat availability is display only, auto-generated based on Maximum Attendees.)
● AllowSelf-Cancellation - Allow users to cancel their registration to this class. (NOTE: Requires

configuration of a cancellation widget.
● Waitlist Enabled - Allow users to place themselves on the waitlist if the event has reached

capacity.
● MaximumWaitlist Size - Number of available waitlist spots (If this is reached, the Add to Waitlist

button will be removed from the occurrence on the event details page)
● Waitlist Response Time - Number of hours a user has to respond to the waitlist notification

email before they are removed from the waitlist.
● ContactName* (Enter the name of the event occurrence contact.)
● Contact Phone (Enter this information in contiguous numbers. The field auto-formats as a

dash-delineated phone number, for example: 800−555−5555.)
● PhoneExtension (Phone extension of contact phone if applicable)
● Contact Email* (Enter the contact emails for the event in email format. Can be displayed on the

front end via the details widget)
● SendNotifications - Will notify listed emails of new registrations and cancellations.
● Notification Emails (Comma separated list of emails that will receive notifications e.g. new

registration and cancellations)
● Roster Request Emails (Comma separated list of emails that are able to request a roster for a

given occurrence of an event.)

Note:An occurrence must be enabled and have a start date in the future in order to show as an active
occurrence on the event details page. Registration must be enabled with a registration start and end
date within the current calendar time frame in order to allow for users to register for the event.

You can delay the onset of registrations by setting a registration date in the future (with registration
enabled.) The registration button will show starting at that date and time. The same is true for
registration end date. If you wish to end registration before the start date\time of an occurrence you
can set that in the occurrence as well.
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Note: ChooseCancel to return to the previous screen without saving any of your changes. Choose
Save andContinue to commit your changes and remain in the edit screen where you canassign adate
and time to the occurrence.

Setting themeetingdate and time for a newly createdoccurrence
A newly created occurrence will be created as an “open” occurrence which means it has no set date and
time. (See types of “Types of Occurrences and How to Create Them” later in this document)

To create a single occurrence or series occurrence, click “Manage Dates” in the left column and select a
date and time for the occurrence to create a single occurrence or multiple dates and times to create a
series occurrence.

Manageexistingoccurrences
For our example below, we chose an event named Event - ACLS Preparatory Course 2 Day Session with
anActiveOccurrence (ID495). Table view, or grid fields are as follows:

● ID (This ID is system-generated when the event occurrence is created.)
● Date&Time (This is the date and time of the event occurrence.) Click to edit this event

occurrence record.)
● Location (This is the location of the event occurrence, whether All, Enabled or Disabled.)
● Presenter (This field holds the name of the event occurrence presenter.)
● Contact (This field holds the name of the event occurrence contact.)
● Edit (Click theEditpencil icon to edit this event occurrence record.)
● RunRoster Report (Click theRunRoster Report (people) icon to run a roster report for this

event occurrence.)

Once in theEdit view, selectOccurrences from the left navigation tabs. TheEdit [Event Occurrence]
screen displays, with theEvent title and the following editable fields. ID (This is the read-onlyEvent
Occurrence IDnumber that is system-generated on creation of the record.)

● Enabled (Check this box to enable display of the occurrence.)
● Registration Enabled (Check this box to enable registration for your event.)
● IncludeGuestDemographic Info (Check this box to include guest demographic information.)
● MaximumAttendees (Enter a number in this field by which to restrict the number of attendees.)
● MaximumGuestAttendees (Specify the maximum number of guests, or additional registrants

for this event occurrence. If the maximum number of additional registrants is reached, the Add
Additional Registrants button disables for the registrant, with a displayed message, stating that
the maximum number of additional registrants has been reached.)

● NotifyContacts (Check this box to notify contacts.)
● Location (Check this box to indicate this as a custom location.)
● CustomLocation (Check this box to indicate this as a custom location.)
● CustomName (This field enables if the Custom Location checkbox is enabled. Enter the name

of the location here, if applicable.)
● Address Line 1 (Enter address line 1 of location.)
● Address Line 2 (Enter address line 2 of location, for example: Suite 100.)
● City (Enter the city of the location.)
● State (Enter the state of the location.)
● Postal Code (Enter the ZIP code of the location.)
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● Latitude (Read-only, unless enabled by the geocode this address button. Enter the latitude of
the location. Latitude is the angular distance of a place north or south of the earth's equator,
usually expressed in degrees, for example: 51° N. To find the latitude and longitude of a
location, use a latitude and longitude finder such as Google Maps.)

● Longitude (Read-only, unless enabled by the geocode this address button. Enter the
longitude of the location. Longitude is the angular distance of a place west or east of the
earth's equator, usually expressed in degrees, for example: 20° E.)

● Presenter (This field holds the name of the event occurrence presenter.)
● ContactName (Enter the name of the event occurrence contact.)
● Contact Phone (Enter this information in contiguous numbers. The field auto-formats as a

dash-delineated phone number, for example: 800−555−5555.)
● Contact PhoneExtension (Enter the phone extension number, where applicable.)
● Contact Email (Enter the contact emails for the event in email format.)
● Availability (Seat availability is display only, auto-generated based on Maximum Attendees.)
● Special Instructions (Click the Show/Hide button to reveal a content WYSIWYG editor that

allows you to format your message as users will view it.)
● Show (Click the Show/Hide button to reveal a content WYSIWYG editor that allows you to

format your message as users will view it.)
● StandardCost (Enter the price of admission in this free-text field.)
● AllowPayOnsite This featurewill only be available if theCart contains payonsite events

exclusively (Read-only)
● CostCenter (Enter the name of the department or other type of unit within your organization to

which costs may be charged, for accounting purposes.)
● RegistrationOpenDate (Enter the event occurrence registration open date, using the calendar

widget that displays when you click the field. The date format is mm/dd/yyyy.)
● RegistrationCloseDate (Enter the event occurrence registration close date, using the calendar

widget that displays when you click the field. The date format is mm/dd/yyyy.)

TypesofOccurrences andhow tocreate them
There are three types of occurrences, the details of which are outlined below.

OpenOccurrence: On occurrence for which there is no set date and time. Open occurrences will show
under event details until they are disabled. Open occurrences can be useful for ad hoc\self-guided
study type of events. It’s important to note that if using an open occurrence for this type of event,
making sure capacity is set to infinite or creating new occurrences as needed is an actively managed
activity.

Open occurrences can also be useful for events that meet on a regular schedule where no registration
is required e.g. Support Group or Walking Clubs. Details regarding the meeting times should be spelled
out elsewhere in the event details. i.e. “Meets every Tuesday in the Oak Ridge Mall atrium at 8am” This
eliminates the need to continuously create occurrences.

Note:Whenyoufirst create a newoccurrence and save, saidoccurrencewill be createdas anopen
occurrence.

SingleOccurrence: A single occurrence is the most common occurrence and meets a specified date
and time. e.g. Sept 25 from 6−8 p.m.
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SeriesOccurrence: A series occurrence is a single occurrence that meets multiple dates and times. The
most common example is a childbirth class that meets over the course of a weekend or at the same
time over consecutive weeks. e.g. Friday 9/25 from 5−8 pm, Saturday 9/26 from 9 am-4 pm and Sunday
9/27 from 1−5 pm A user needs only to register once to attend all sessions in the series.

Creating recurringoccurrences
If your event has multiple occurrences that meet on a set schedule, it is possible to use an occurrence
to create multiple individual occurrences in the future using the ‘recurring occurrences’ tool.

To start, select an occurrence that will serve as the template as all the data contained within that
occurrence will be copied over to the newly created occurrences. From the occurrence details, select
“Recurrence” and then select “Creating Recurring Occurrence” being sure to make note of the
information in the blue box.

Select the frequency of the recurrence e.g. daily, weekly or monthly and the interval.

Depending on which option is selected, you may be presented with more options.

Select the recurrence start date and end date as well as a start and end time. Recurrences will be
created on all dates between these two dates that meet the frequency criteria.

Click “Save and Return to List” where you will see all the new occurrences you have just created. You can
adjust or delete occurrences that may fall on a holiday by selecting the occurrence and managing the
dates.

Registration Forms

TheEvent Registration Forms screen allows you to create, edit or remove customEvent Registration
Forms.

To access this page, choose theRegistration Form link from the mainContentApps Eventsmenu, or
from theData tab drop-down menu option in theEventsContentApp.
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TheEvent Registration Formspage displays. Each row, or record displays columns as listed below. The
columns are sortable, as described in the Using the Column Sorting Options topic.

● ID (FilterEvent Registration Formsby the system-generated ID that was created when the form
was created.)

● FormName (This is the form or TemplateNameentered when theEvent Registration Formwas
created. Click this link to open the edit screen for the form. See)

● Actions (Click theEditpencil icon to edit the form on this row (alternate method). The edit
screen for the form displays. Click theCopy icon to generate a copy of the form here.

TheNewTemplate screen displays, as shown below. Create a Registration Form by defining a Template
Name for your template in the required field.
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Howtoedit, copyand repurpose aRegistration Form
To copy an existing registration form, simply click the copy icon as indicated in the image below. Your
copied form is immediately ready for use at the bottom of the list, with a confirmation message stating
that theEvent Registration Formwas successfully copied.

Click the form name or pencil (Edit) icon to rename the form or revise the content by left and right
columns.

For our example, the Registration Form - Waitlist Copy opens to theEdit Registration Form screen,
defaulted to theBasic Information tab, where you can change the name of your template.

There are three navigation tabs:
● Basic Information
● ID (This is the read-onlyEvent Registration Template ID that was system-generated when you

copied the record.)
● TemplateName (Edit your template name using this free-text entry field.)
● Left (or Right)Column
● FieldName (This is the non-editable field name.)
● Field Label (This is the display name of the field. Add the text you want the registrants to view.

For example: Add Me to the Cardio Care Newsletter.)
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● FieldDescription (Enter descriptive text about the field to give your registrants a better idea of
how to use it. In our example above, we added a 415−character description for the newsletter.)

● Is Required (Check this box to make this field required. When enabled, the user must respond in
order to save the form.)

● Data Type (This is the read-only data type of the field. In this case: Drop-down.)
● Drop-downOptions (Add your drop-down options in this free-text entry field.)

Button options areCancel, SaveandReturn to ListandSave.

Once your form has saved successfully, as demonstrated above, access theScheduled Task -Events
Site SearchSynchronizer to synchronize your changes, so they can be seen on the published page  

WebMD IgniteBest Practices:

WebMD Ignite recommendsavoiding thecollectionor storageof sensitiveor confidential
informationwhenaddingcustomfields to theevent registration form.

Sensitive andconfidential information includes, but is not limited to. ProtectedHealth Information
(PHI) or patient data, social security numbers, or credit card numbers.

ManageEventAppSettings

If you need to edit an event, navigate to the Events Content App.

To access Content App components from anywhere within CMS, click the Content Apps icon from the
CMS left menu.

To edit event app settings, you will want to access the settings.
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Now you’ll see several options within the settings screen, including search settings, detail settings, SEO
settings, Cart settings, Cancellation settings, and Roster Report settings.

Most of these you should never have to adjust.Note that if you adjust someof these settings, itwould
bebest to have aWebMD Ignite developer towalk you through it.

SearchSettings
Search settings lets you adjust how your events populate on your search results page.

● SearchResults PageURL: Please do not touch this without discussing it with a WebMD Ignite
developer first.
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● Default PageSize: Adjust the number of events that present on the results page by changing
this number.

● Pager Position: Choose where the pagination for your events sits - Top, Bottom, or both Top
and Bottom.

● ZipCodeSearchResultsOptions: Adjust the radii options for your search filtering.
● Site Search Index: If you aren’t seeing an event in your search results but have verified that the

event is enabled, published, and has an active occurrence, then come here and click on the
“Refresh Site Search Index” button. Sometimes things will get caught up in G2 search caching;
clicking this button helps refresh the site search.

Detail Settings
The Details settings adjust the details pages for your events.

● Detail PageURL: Please do not make any changes to this field without discussing it with your
WebMD Ignite representative first.

● DirectURLPath:Please do not make any changes to this field without discussing it with your
WebMD Ignite representative first.

● DirectURL Formula: If you’d like to adjust the end part of your location’s relative path to include
di�erent information, you can use this Direct URL Formula to make edits using the available
tokens. You can also insert your own language between tokens. Note that this formula, unless
overridden at the specific event instance, will hold true for ALL events on your site.

● Default Event ImageURL: If you’re using a default image that is di�erent from the one that was
originally set up for your site, enter the relative path here.

SEOSettings
The SEO settings change the SEO for your events.
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Use the available tokens, your own language, or a combination of the two to develop a standard SEO
formula for all of your events. You can set specific formulas for Title, Description, and more.

Cart Settings
The Cart settings adjust the cart page for your events.

Choose the timeframe for when an event is considered abandoned and is canceled. The default time is
15 minutes. Here you can also disable the cart or add multiple confirmation emails.

CancellationSettings
The Cart settings adjust the cart page for your events.

Enter the URL for your cancellation page in the Cancellation Page URL field. Enter an internal contact’s
email (option) into the Refund Failure Contacts field. If you want to allow event registrants the option to
cancel their registrations on their own, make sure that Enable Self-Cancellation is clicked.

Roster Request Settings
Roster request settings lets you enter the email addresses for those internal individuals who are
authorized to receive event registration roster lists from the system.

Registrant Search

The Registrant Search option allows you to search and view event registrant information. This page
contains a filter to assist with locating event registrants and events by name, with options to Apply (run
the filter based on your selections), or to Clear Filter.

To access this page, choose the Registrant Search link from the main Content App Events menu, or from
the Events Data tab drop-down menu option.
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Once on the registrant search page, you’ll be presented with a whole host of filtering options to help
you refine your search:

● ID: Filter the event registry to locate a registrant by ID. This is the system-generated transaction
ID that was created when the registrant paid for the event occurrence. Use this filter to quickly
match event registrants to payment transactions in either Payflow Pro or Authorize.net. This is
useful to reconcile payment transactions, or for cancellations, when you need to issue a refund.

● RegistrantNameBegin typing the name of an event registrant to populate an alphabetized
listing for this filter.

● Registrant Email:Begin typing the email address of an event registrant to populate an
alphabetized listing for this filter.

● Event: To quickly locate registrants for a specific event, first make a selection from these
drop-down options, then use the Event Occurrence filter. The type-ahead feature is available
for this field.

● EventOccurrence: This field Is dependent on the Event field selection above. Once an event is
selected, choose an event occurrence from the list in the format (ID - Date Time).

● Registrant Status: Options are Active or Removed. Use the Registrant Status filter to retrieve
and view information on registrants that were previously removed from an event.

Once you’ve filtered for and found your registrant, click on their name toedit their information, resend
confirmation emails,or remove them from theevent occurrence. Remove is in the lower right hand
corner once in the registrant information screen. You can also resend confirmation emails from this
screen.

Event Reports

The event reporting tool can be used to report on nearly every aspect of events including events,
occurrences and registrants.

Reports can be shared across all event admins or marked as private and only available to the user that
created the report.

To get started, selectReports from the Events card in the content apps admin.
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This will bring up a list of any existing reports accessible to you (either those created by you or others
marked public or your reports marked private.)

CreateNewReport
To create a new report, select “Create New” in the bottom right corner of the screen.

A wizard style guide will step you through the four part process in creating a report.

Note: It’s a good idea to save the report periodically as you go so any changes are not lost due to
connectivity or timeout issues.

Details
Enter a name (required) and description (optional) in the fields. If you want to limit access to the report
to only you, tick the box markedPrivate. This is a good idea if you expect to make multiple reports that
are only to be used by you as it will keep the reports interface free of clutter for other users.

ClickSaveReport and thenNext Step.

Fields
The next step involves selecting and organizing the fields you wish to include on your report. The fields
are organized into three sections: Event Fields, Occurrence Fields and Registrant Fields and contain
nearly every attribute in COD10 events that can hold data. To include a field on your report, drag it from
the pane on the left to the pane on the right. The order will determine column order in the resulting
report. To remove a column, simply drag it from the pane on the right back to the pane on the left.

Once you have selected the fields, clickSaveReport and then clickNext Step.
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Query
The next step is to define the query on which you want to search. Similar to the fields tab, you can query
against almost any field that stores data in the COD10 events application.

There are two modes:SimpleandAdvanced.

Simple allows you to build a cluster of AND statements that will be evaluated against the fields queried
to return results. You can add additional groups which will be evaluated as OR statements. Statements
within these groups will be evaluated as AND statements as well.

Select the field you want to query against by using the dropdown and then the operator (e.g. equals,
contains, does not contain, greater than etc. These operators will change depending on the field
selected\data type contained within the field.)

The scope of the query is completely configurable. There is no right or wrong way to build a query. Note
that a broad query may return a large number of results while a highly specific query could return no
results at all.
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TheAdvancedquery builder allows for building nested queries using a mix of AND or OR operators.

Once you have built your query, clickSaveReportand thenNext Step.

Results
Now that you have added your fields and built your query, it’s time to run the report and see your results
set. Click “Run Report” to see the items that match your query and the fields you included in your report.

Once you have run the report, you can click the green “Download” button to generate a CSV of your
result set.

If you receive a message that says “No results found” you may need to adjust your query to be less
specific.

This video goes into more detail about how to e�ectively use reporting.

Email Templates

Email Templates save time and support accuracy in communications with your event registrants. You
can configure di�erent email templates for use across di�erent types of classes with consistent
messaging and branding. E.g. A virtual\online class that contains instructions on how to download
Zoom etc. vs an in-person class that contains a Google Maps link with directions to the class.

There are four emails that may be sent to registrants of a class which can be customized and templated:
● Event Registration Confirmation
● Events Admin Cancel Attendee (If the registrant is canceled)
● Event Registration Reminder (If reminders are enabled on the event)
● Event Roster Notification (Ad hoc email sent manually to current registrants containing updates

to an event)

Additionally, there are several administrative emails sent by the Events module that can be customized,
but not templated. i.e. You can’t choose a di�erent template on a per event basis.

These include:
● Event Registration Contact Notification
● Event Roster Request
● Event Roster Summary
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● Event Waitlist Confirmation
● Event Waitlist Registration
● Events Admin Cancel Contact
● Events Admin Refund Failures

COD10 has default email templates already set up for each of these communications. You may edit the
default templates or create new ones and assign them to classes as needed.

Editing thedefault email templates
In content apps in theConfigurationpane, click on Templates.

A list of all existing email templates will display. The default templates will haveDefault listed in the type
column. Any custom email templates will have the type of email (e.g., Event Confirmation) listed in the
Type column.

To edit an existing template, click on the name or edit icon corresponding to the email you wish to edit.

Each of these email templates have the same form fields, as described below:
● FromAddress (Enter a properly-formattedFromemail address (email@domain.com) in this

free-text field.)Note: In order to use a non-Webmd email address you must follow the
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instructions in the SPF & Whitelisting Updates section of this document to allow emails to be
sent from your organization’s domain.

● Subject (Enter the subject of your email in this free-text field.)
● Body (The fields in this section comprise the body of your email. Use the formatting tools in the

includedWYSIWYGeditor to style the text elements of your email. Drag applicable tokens
onto the body text where needed to personalize your message with existing data about the
recipient and event.)

● Hide (Expand/contract this control toShow/Hide theBody section of this email template.)

The body text allows you to compose the contents of your email and dynamically insert values related
to the event and registrant using the tokens from field tokens pane to the left of the body.

Arrange the text of your email and any related tokens as needed and press save.

Note: The $EventsInfoStart$ and $EventsInfoEnd$ tokens must wrap any event-related tokens e.g.
Event Title, Special Instructions, Location etc.

Creating a new template
From the list of existing templates, selectCreateNew then select from one of the four template types
in the dropdown menu.

Template name, From Address and Subject are required. You may optionally add a description of the
template.

Depending on the template type selected, the body of the email will be pre-populated with the default
text and tokens. Edit the template as needed and press save.

Usingcustom templates onEvents
To assign a custom template to an event, selectEmails Templates from the left column of tabs in the
event record. You can then select your custom templates from the dropdown of each email type.
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Note:You can also create a one-o� custom email template from within each event record by selecting
“Custom” from the dropdown menu. The process is the same as creating a new template, however the
template will not be saved and available for use by other events.

SPF&WhitelistingUpdates

If you’re wanting your event registration emails to come from an email address that you manage (i.e.,
classes@yourorganization.org), you will need to create SPF records with your IT team and ensure that
your events are set up to send from your internal email address.

For your website that is hosted by WebMD Ignite on the Crownpeak platform, you will need to do the
following:

● Create an SPF record to send from the following two IP addresses:
149.72.63.232

● Whitelist medseek.com within your email server so emails that don’t originate from your domain
are not rejected

You can check your SPF records here.

You will also need to check to make sure that your events are set up to use the correct sender email
address from within the content apps.

If registrants are receiving emails, but they’re coming from the wrong FROM address, that signifies an
email template configuration issue. Log into the Crownpeak platform and access your Events content
apps to fix this.

ClickEvents List to search for the event that’s sent incorrectly. Enter the event name into the keyword
box.
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Click on your event to edit it.

Looks forEmail Templates in the left-hand navigation of your event:
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You should see three event templates you can edit:
● Event Confirmation Email
● Event Reminder Email
● Event Cancellation Email

ClickViewTemplate to edit.

Once inside the event template, you’ll see one of two layouts:

OR
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Services
Note:Before adding or editing Services, check with your WebMD Ignite representative. This
functionality is not used by all site instances.

This section allows you to set up a dynamic services search, similar to Providers, Events and Locations
where there is a Services search page, results page and details page.

Setting up services this way is optional and most clients do not use this feature. However, when it is
used, it allows Services data to be available in the form of a ‘token’ which can be used in the ‘Services’
section of a location and pulled in dynamically where needed, rather than entered manually. The most
popular use case for this is creating a Service record that acts as a pointer link to the actual service line
page (which is typically a more robust page) and attaching that pointer to a Locations record. We will
demonstrate this below.

Navigate toContentApps>Services

ClickServices List.
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ClickAddNewbutton.

In this example above, the Services detail page would use the Name listed above as the H1. And its
contents would be the link showing in the description.

The SEO fields allow you to customize the SEO settings for this services page.

In e�ect, used in the way described above (and how this is typically used) is to provide a link to actual
service line pages. Now this record is available as a token.

Now you can go into the Locations details widget and drag this token over into the Services tab by
clicking theAddExistingbutton. (search for ‘Radiation Therapy’, select and press ‘Add’.)
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Now that ‘Radiation Therapy’ service term is associated with the Acme Medical Center, the radiation link
(and any other service related data entered as part of that services record, is now pulled into this Acme
location record.

Taxonomy
Taxonomy is a very powerful way to help create a more robust search functionality for your users.
However, keep in mind that if not approached carefully, taxonomy can also potentially cripple your site
search e�ectiveness. Remember that sometimes less is more.

When you develop your taxonomy keyword list, you must think about the end user and how they search.
You can also use third-party tools to help you: Google Analytics will tell you what users are searching for
on your site today, keyword planning tools, Google Trends, etc.

WebMD Ignite has a taxonomy approach that we can help you implement if you’d like. Ask your team for
more information.

The taxonomy functionality can be found under your content apps.
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The simplest way to develop your terms and terms associations is to think of them very broadly. The
easiest way is to create three buckets for each of your service lines: a general bucket, a conditions
bucket, and a procedures bucket.

To create these buckets, click on your Terms List in the Taxonomy box and Create New.

A modal will pop up where you can enter one taxonomy bucket or multiple buckets. If you are entering
multiple buckets, be sure to put only one on each line. You cannot use commas to separate, you have to
use a hard return.

Once your bucket(s) is(are) created, you can add synonyms. Click the pencil icon to edit.
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Synonyms should be separated by a comma with no spaces between them. Spaces indicate to the
system long-tail keywords. Examples:

You do not need to clickGrouping Term.

Once all of your synonyms are entered, you need to pull them into the taxonomy architecture. Navigate
to Terms Association either through the content apps card or through the dropdown menu at the top of
the taxonomy content app:
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Tree View is easier to use, so toggle to Tree View:

On the Terms bar at the top, click the plus sign all the way to the right to add a new term:

Once all of your terms have been pulled into the tree view, you can drag and drop them so they nestle
appropriately. The best approach is to take your three buckets for each service line, having the general
be the service line bucket and nestling the other two (Conditions) and (Procedures) as children of that
term. You should end up with something like the following:

Assign taxonomy term toproviders/locations/events/services

Now that you’ve entered all your keyword buckets and synonyms and associated them in the tree view,
it’s time to start adding them to areas throughout the site.

Let’s start withProviders. Navigate to your Providers content app and click on Specialties:
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Following these steps will append all of your synonyms to every single provider on your site who has that
specialty. Choose your specialty from the list and click through to the taxonomy tab. In the field next to
TaxonomyTerms start typing in the name of the taxonomy bucket you want to append to that specialty.
When you’re done, clickSave. Repeat this process for all specialties.

Note: You may have some physicians who want additional or fewer terms applied to their profiles. This is
easily manipulated in that specific provider’s profile. Navigate to the provider content app and search
for your specific provider.

You should see a list ofE�ectiveKeywords if you have completed the previous steps. You will also see
additional fields forCustomKeywordsandExcludedKeywords. Custom keywords is where you will
add any keywords not already on the list of e�ective keywords. Excluded keywords is where you will
add keywords for which the provider does not want to present in query results.
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The approach for Locations is exactly the same, however, you will access Services from the Locations
menu:

Adding taxonomy to events must be done at the individual event level. In the Event edit screen you will
see a taxonomy tab where you can pull in your existing buckets or add custom keywords. Note: this can
only be done at the main event level. Each occurrence inherits the taxonomy from the main event listing.
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You can also add taxonomy at the individual page level. If you view your page in Preview and hover over
the bottom of the page, you’ll see a meta configuration box pop up.

You’ll see an option for Taxonomy where you can begin typing the appropriate bucket(s) you want to
append to your page.
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Save and deploy to live when you’re finished.

Of important note is that you may need to adjust your search widgets to search using “starts with”
instead of “contains” to ensure a better user result. For instance, if you’re using “contains” and someone
queries “urgent care”, the site will look for all pages using both “urgent” and “care” vs. if you have “starts
with” as your query, it will look for “urgent care”.

ContentAppsconfiguration
Introduction
The Configuration section within the content apps allows administrators to interact with the CMS to
configure and manage various functions that support the user experience. Activities available within the
Configuration section include:

● Payment Gateway
● Health Content
● Custom List Layouts
● Scheduled Tasks
● Custom Links
● Dynamic Columns
● Data Import
● Roles
● Email Templates
● System Settings
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PaymentGateway

The Payment Gateway allows administrators to configure and manage online payment vendors for use
with Event Registration and online payment. There are three supported payment vendors within the
CMS - Authorize.Net, PayPal PayFlow Pro and Tempus.

On successful payment, a confirmation page is displayed to the Event Registrant along with an email
confirmation.

Of important note - an account with the online payment vendor must be created prior to creating this
configuration.

SelectingCreateNewwill present the (3) available payment processors.
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Once completed, select theSaveorSave andReturn to Listbutton.

ToEdit a record, select thepencil icon to the right of the desired entry.

In order to associate a payment processor with an online registration form, please review the Events
Management Content Apps Registration form set up.

CustomList Layout
A custom list layout is used to create and curate a specific set of content to be displayed on a page. This
configuration option allows the administrator to control the layout of this area.

SelectingNewwill display the following screen:
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● Id - a dynamically assigned numeral value
● Name - name of custom list
● Content Type - dropdown of all available content types, both data driven and content
● Header Layout - WYSIWYG field to style the content of the header section
● ItemLayout - WYSIWYG and token field field to configure and style the content of the actual list
● ItemSeparator Layout - WYSIWYG field to style the content
● Footer Layout - WYSIWYG field to style the content or the footer

Once completed, select theSaveorSave andReturn to List button.

ToEdita record, select thepencil icon to the right of the desired entry

Scheduled Tasks

The Scheduled Tasks area of the Configuration is a real-time dashboard of all ongoing activities the
CMS relies upon to stay continually updated. An administrator can both view and manage scheduled
tasks within the system.

● Name - name of the schedule task
● Schedule - when the scheduled task is scheduled to run
● Next Run - specific time until next scheduled run
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● Status - status of the task (waiting, success, error, etc)
● TaskQueue - the
● Last Run - the last time the task run was completed

Actions - an administrator can manually kick o� a task by selecting theRun Task icon. The status
will update to show the task is in progress. Additionally, selecting theEdit icon allows the administrator
to view the task details, set schedule, and can also choose to run the task by selectingRunNow:

DynamicColumns

A Dynamic Column is used when there is not an appropriate field or field type available within the basic
field set of the Provider, Location, Events content apps. This can be the case for either a user
experience need or a data integration requirement.

To create a new Dynamic column, select theNewbutton
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There are three sections to be completed:

Basic Information
● Id - a dynamically assigned numeral value
● Content Type - the content app data type (Provider, Location, Event)
● FieldName - admin side name of the field - this value can not be edited after creation
● Field Label - user side label; editable after creation
● FieldDescription - description of the dynamic column function
● SectionHeader - header that displays the field in the admin UI. Multiple fields with the same

heading , and having sequential sort order values will share a single section header
● SortOrder - the order in which fields are displayed in the admin UI

FieldData
● Data Type - the type of field - options are text, number, date, dropdown*, content editor

Dropdown - if data type = dropdown, configuration for the dropdown options appear here
● MaxLength - numerical value of maximum character limit for field
● IsMulti line - if checkbox is selected, the field can accommodate multiple lines
● Is Required - if checkbox is selected, the field is required
● ReadOnly - if checkbox is selected, the field is read only

FieldOptions
● Include in Site Search - if checkbox is selected, dynamic column is included in site search and

accessible within custom lists
● Include inKeywordSearch - if checkbox is selected, dynamic column is included in widget

keyword search
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● Available inWidgetDefaultQueries - if checkbox is selected, dynamic column is available in
the default query setting of search result widgets

WizardOptions
WizardStep - only used when content type = event. Dropdown field to dictate what step the dynamic
column should appear within the wizard workflow

Once completed, select theSaveorSave andReturn to List button.

ToEdit a record, select thepencil icon to the right of the desired entry.

Data Import

The Data Import configuration feature allows the CMS Administrator to configure data sources for
import. As this feature requires additional set up and subscription services, please consult a WebMD
Ignite representative for more information.

DigitalQualityManagement
Digital Quality Management (DQM) is a platform that provides reporting, by a library of continually
updated digital technical and legal specification standards on all issues detected on your site, whether
your site is Live, in development or inStaging.

HGCMSV3DQMCapabilities
WebMD Ignite CMS Digital Quality Management (DQM) is a cutting edge, cloud-based platform that
provides up-to-the-minute reporting, by a library of continually updated digital, technical and legal
specification standards on all issues detected on your site, whether it is Live, inDevelopmentor in
Staging.

HG CMS V3 DQM provides the only automated digital governance solution that integrates directly with
your healthcare web Content Management Solution (CMS), assuring a high-quality, consistent
customer experience across every page and asset of your site.

With DQM, you can quickly target and resolve SEO issues, which can a�ect how easily your pages are
found, and ultimately conversion rates, using included best practices and rule customization.

WithDQM, you can:
● View a consolidated analysis of error classifications on all your web pages from a central

dashboard.
● Ensure Web Content Accessibility Guidelines (WCAG) 1.0 and 2.0 and Section 508 accessibility

standards-compliant content. For more information, see Accessibility in DQM.
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● Easily correct details such as broken links, orphaned pages, readability and misspellings (in
multiple languages), which can have a strong impact on public perception.

● Quickly target and resolve Search Engine Optimization (SEO) issues, which can a�ect how
easily your pages are found, and ultimately conversion rates, using included best practices and
rule customization.

● Quickly target and resolve URL structure and code issues, as well as privacy and cookie policy
inclusion and mobile device optimization.

● Automatically monitor your digital properties 24/7, by crawling your sites, regardless of
channel, with configurable frequency. (All dashboards are set up for weekly scanning.)

● Protect your brand with reporting for brand violations, such as usage of an incorrect logo or
color palette, incorrect font, punctuation or image assets, consistent use of terminology,
language clarity, use of prohibited terms, etc., across all digital experiences.

● Detects and tracks key digital assets across all of your sites, making it easy to review and
replace files.

Take yourwebpresence to the next level byproactively detecting and resolving allmajor digital
presence issues.

Accessibility inDQMdefinitions
Providing a good user experience is crucial for the success of any website. For users with limited
abilities, browsing a website can be di�cult. Improving your website so that it is easy to navigate for all
users increases your range of potential customers and improves your SEO1.

What isWCAG?

The World Wide Web Consortium (W3C) has published Web Content Accessibility Guidelines (WCAG) in
order to help businesses make their websites accessible for users with disabilities, or users with limited
devices (such as mobile phone and tablets). The latest guidelines released are the WCAG 2.0 on which
DQM bases their checkpoints.

What are accessibility Levels A,AAandAAA?
These levels indicate the degree of compliance. While level A covers the basic needs of a website to be
easily accessible, level AA and AAA are based on higher standards. Most businesses aim to achieve a
level of at least AA.

What is aBenchmarkingScore?

TheBenchmarkingScorewill give you an indication of how compliant your website is to WCAG
standards. The score ranks from 1 (low) to 10 (high). However, please note that the level AA and AAA
contain checkpoints that cannot be tested by scanning your website. For those, you will need to check
your pages manually. An example for a manual checkpoint would be, whether your website has
supporting audio or whether the colors used in the design are easy to see for a person with impaired
vision.

1 The object of Search Engine Optimization (SEO) is increasing targeted internet tra�c and ultimately
your Return on Investment (ROI). This is best achieved by improving your search rankings, by optimizing
your pages, so that search engines can find them.
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Why is onecheckpoint flagged for a lot ofmypages?

There are a number of reasons why one checkpoint exists on many pages. The first reason could be that
the flagged item is a part of your website’s template and is shown incorrectly on every page. In this
case, fixing the issue in one place will resolve many of your checkpoints at once. Another possible
reason could be images without alt tags.

What are alt tags andwhyare they important?

Thealt tag is contained within the image tag<img>. Althoughaltand titleare commonly referred to as
alt tagoralt textand title tag, they are not actually tags. Alt and title are attributes of the HTML image
<img> tag.

A complete HTML imagealt tag is written as follows:
<img src=“my_image.png” alt=“my image description” title=“image tooltip”>Thealt text (alt=“) should
describe the image and its purpose.

Images without alt tags are highlighted as checkpoints for a few important reasons. Configuration is
available to restrict saving pages without an alt tag for all of your images, if desired.

Alt tags are important for 508 compliance screen readers, such as Job Access with Speech (JAWS),
which generates audial speech and Braille output for users with vision impairment.

Images whose intent is strictly design-based, that are in the HTML of your page rather than in the
preferred CSS, should have an empty alt tag attribute, for example: <img src="my_image.png" alt="">,
so that screen readers will skip over that image.

Alt tags are also important for SEO. The titleattribute is displayed as a tooltip when a site visitor hovers
over the image. It can even be used as an additional call-to-action (CTA), for example: “This service is
now o�ered at a reduced price!”

Alt tags with a title attribute also provide a text alternative for search engine crawlers and robots such as
Googlebot and can positively impact search engine rankings. Images with correctly-formatted alt tag
attribute titles influence both indexing and ranking of the page. They also enrich the user experience for
those using browsers that cannot process images.

Another reason to use the title attribute: Firefox, Chrome, and other HTML W3C standard-compliant
browsers won’t display hover text for images if the title attribute is not present or is empty.

Other commoncomplianceerrors

A warning for meaningless phrases such as "Click here." used for link text may seem trivial, but there is an
important reason for this compliance flag. The intent is that link phrases should make sense when read
out of context, for screen readers.

JAWS has an option to display a list of links on the page to the user. Along with this, JAWS has an option
to list all headings on a page and is a popular way for visually-impaired users to orient themselves and
more quickly discover what they're looking for in a document.
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Priority flag
Issues with priorities are flagged as displayed below.

Non-compliance can be a costly mistake for websites that do not provide accessibility to all.

Wherecan I findhelp understanding acheckpoint?

At the end of each checkpoint is an informationWhy? icon. Hover over this icon for a quick view of
additional information regarding why resolution of this checkpoint is important. Click on the issue itself,
and the Source tab to directly access the problem area in the code.

Howdoes theDQMplatformwork?
TheDQMplatform works on three levels. TheDQMplatform routinely crawls your websites and
monitors for any violations based on the rules and priorities in place, without a�ecting performance.
Crawl frequency is weekly. Priority issues are flagged for immediate attention.

This information is analyzed, organized and presented in an intuitive and comprehensive online
dashboard, known as theWebsiteDashboard, to ensure quality and compliance for your live web
presence.

Once installed, theDQMPageChecker tab validates any selected web page with one click, for these
same brand, code, compliance, SEO and compliance risks, using the rules and priorities you have set.
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As you are building your site's pages, theDQM report accordion validates against all of these
configured rules in place, so that you can address any issues prior to publishing.

PageChecker
When you receive your DQM user account and log in to the platform, you will notice an orange button at
the top-center of the Website Dashboard Overview page.

If you are in Chrome, first be sure the bookmarks bar is displaying (Ctrl + Shift + B). Click the Install DQM
Page Checker button.

The instruction screen displays. Drag the orange box to the browser bookmarks bar, as shown below, in
Chrome. You will see a "+" sign in a white box when you are over the correct area of the bar.
Release the mouse button. The install is instantaneous. Click the Got it! button to close the instruction
screen.

Once you have installed the DQM Page Checker, your browser view should have a bookmark, as shown
below.
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InstallingPageChecker inMSEdge

Installing theDQMPageChecker in MS Edge involves the same steps, with one exception.

You must first display the MS Edge Favorites bar, by, if you have not already, right-clicking to the right of
the address bar and selecting Favorites Bar. This will provide space under the address bar for
bookmarks.

Continue, as above using the Install DQMPageCheckerbutton.

This is theDQMPageChecker installed in MS Edge. Go to a site and click it for an instant evaluation,
based on the currently configured rules in place.

Using theDQMPageChecker

You can now use theDQMPageCheckeron any site. Go to any site, then click theDQMPageChecker
bookmark we just created. You can view the issues on that web page listed, and highlighted as
demonstrated on our demo site, for whichever issue you click.

You can check any site to compare how your site rates against competitors, without having access to
the CMS.

Assists your site editors in bothpre andpost publicationmode.

InlineQualityManagement
Let's start at the ground level, the authoring environment for your website. To analyze and correct an
individual page in your site, you can use the dockableDigitalQualityManagementpanel. With your
page open in Inline view, you can see problem areas highlighted in yellow. Open theDQMpanel by
clickingView>DigitalQualityManagement.

The pie chart shows yourPass/Fail statistics visually and in percentages. The blue area and
coordinating blue bullets below it, indicate compliant (Pass) items. The red chart percentage and
bullets are your problem (Fail) areas. Use the drop-down menu to viewPass/Fail information by
category.

Categories are: All Topics, Accessibility, Brand, Legal, SEO and Usability. The pie chart and bullets
update accordingly. Errors and their solutions are defined in readable language withViewMore links for
additional information, withWebContentGuidelines (WCAG) 2.0 section references.

Accessing theDQMWebsiteDashboard from theCMSApplication

You can view DQM information from a couple of places in the CMS application. To quickly overview
problem pages in your site and address them from one source, use the DQM Website Dashboard.
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● To access the DQM Website Dashboard, click the DQM icon from the left-hand panel. This is a
link to the dashboard view. Log in with the username and password provided to you by your
administrator.

Viewing a singlepage in theDQMDashboard from theCMSAuthoring Environment

You can also open a single page in the DQM Website Dashboard from within the CMS application. From
an open page, whether in Preview, Inline or Form view, go to the Last Published Link icon and select an
option. For our demonstration, we chose Live.

DQMDashboard (external)
The onlineDQMWebsiteDashboard is also known as TheAnalyzer. There are four tabs: Overview,
Issues (with options: Priority issues, All issues, Issues by topic, Worst pages),Spelling, (with options:
Misspellings by word, Misspellings by page) InventoryandAccessibility. You can tackle the largest
issues first, by selectingWorst pages from the Issues tab menu.
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Much of your time will be spent within Issues. Issuescan be designated as prioritized. Standards can
range from content presentation, links and images to URL structure and cookies. You can view the full
list of Issues, as shown.

Working with these tools empowers your content management team, by reducing the chance of
compliance issues that can be created, so they can focus on creating conversion-centric content for
your organization.

You can have as many websites in the platform as desired and administer each one on a separate
dashboard.

The following table lists all the rules from this page.

Category Rule

Color: #132D77 All pages should contain headings.

Content All pages should contain an <h1> heading.

Content Do not use underlining to highlight text.
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Content Large blocks of content should be broken up using
subheadings.

Content Do not artificially create bullet lists.

Content Do not use bold <b> tags to emphasize text.

Content Do not use italic <i> tags to emphasize text.

Content Do not have multiple headings with identical text.

Content All data tables should correctly define header rows
and column headers.

Content Use correctly nested headings.

Content Do not create blinking text.

Content Do not use justified text.

Content Paragraphs should be no longer than 100 words in
length.

Content H1 Headings should be no longer than 10 words in
length.

Content H2 Headings should be no longer than 10 words in
length.

Content H3 Headings should be no longer than 10 words in
length.

Content Do not use “Submit" as button text.

Content Do not overuse uppercase formatting.

Links Do not use meaningless phrases such as "click
here" or "more" as the entire link text.

Links Do not have links without content.

Links Indicate when a link will open in a new window.

Links If an image is the only content in a link it must have
"alt" text.

Links Combine adjacent links together if they have the
same destination.

Links Broken external links.

Links Broken internal links.

Links Broken images.

Links Do not make links too long.

Images All images should specify an "alt" attribute.
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Images Provide "alt" text for each clickable hotspot within
an image map (not for mobile).

Images Image "alt" attribute should not be empty, except
for on known "decorative" images.

Images Image "alt" text should contain more than one
word.

Images Graphical form buttons should have "alt" text.

Images Do not provide text alternatives for decorative
images.

Images Images between 50 - 200 KB.

Images Images between 200 - 500 KB.

Images Do not use unsuitable image file formats.

Images Images larger than 500 KB.

Rich Media PDFs should be tagged for accessibility.

Rich Media PDFs should have a meaningful title specified.

Rich Media EMBED tags must have an associated NOEMBED
tag.

Rich Media Specify the file type when linking to non-HTML files.

Rich Media Include information about document size within or
next to the link.

Tile and
Metadata Does the page contain a title tag?

Tile and
Metadata Is the title tag populated?

Tile and
Metadata Does the title tag contain more than one word?

Tile and
Metadata

Pages should specify the natural language of a
document.

Tile and
Metadata Do not use meta refresh with a time limit.

Tile and
Metadata Pages should contain metadata description.

Tile and
Metadata Limit <title> tags to 60 characters or less.

Tile and
Metadata The title tag should contain the company name.

Tile and
Metadata Do not use multiple title tags.

Template Copyright date should be the current year.

Writing Style Do not use white space characters to control
spacing within a word.
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Brand Always capitalize the company name correctly.

Brand Always spell the company name correctly.

URL Structure
and Code Do not use deprecated tags or attributes.

URL Structure
and Code Use relative font measurements.

URL Structure
and Code

Use linked style sheets to control layout and
presentation.

URL Structure
and Code

If using frames (or iframes) make sure they are
titled.

URL Structure
and Code ID values must be unique.

URL Structure
and Code Do not use "onmouseout" without "onblur".

URL Structure
and Code Do not use "onmouseup" without "onkeyup".

URL Structure
and Code Do not use "onmouseover" without "onfocus".

URL Structure
and Code Do not use "onmousedown" without "onkeydown".

URL Structure
and Code

Table summaries must not duplicate table
captions.

URL Structure
and Code

Do not use scripting to remove focus when focus is
received.

URL Structure
and Code Do not use pre-ticked boxes in forms.

URL Structure
and Code Do not use inline styles.

URL Structure
and Code Deliver all code as UTF-8.

URL Structure
and Code

Do not use special characters within file or
directory names (URLs).

Privacy and
Cookies All pages should contain a privacy link.

Privacy and
Cookies All pages should contain a link to cookies policy.

Privacy and
Cookies Do not use Flash.

Privacy and
Cookies Do not use graphics for spacing.

Privacy and
Cookies

Do not use onmouse and onkey triggers within your
scripting.

Privacy and
Cookies Set the viewport on pages.

Privacy and
Cookies Do not disable or suppress the ability to zoom.

Mobile Do not use nested tables.
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Mobile All pages should have a link to the desktop version
of the site.

Mobile Do not use the title attribute unless on a form input.

Resolving an Issueby Topic in theWebsiteDashboard

For our demonstration of resolving issues in theWebsiteDashboard, we will look at Issues> Issuesby
Topic, Links. We clicked on the Links topic,DoNotHave LinksWithoutContent. The right side of the
page populates with the pages a�ected and statistics.

Clicking on a link displays the actual live page, where the link is broken, with the issue area highlighted in
theSourcecode.
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Click the Information iconⒾ to view why resolving links without content is important. The text states:
Although these empty links will not be visible on the page, they will be apparent to some users and
cause confusion. For example, some browsers will allow tabbing to empty links and assistive
technology will also announce the presence of a link.

In addition, linkswithout contentwill bepickedupby searchengines,whichmay interpret themas
spamandpenalize thewebsite.

MisspellingsbyWord

CheckMisspellingsbyWordunder theSpelling tab of theWebsiteDashboard application. The
misspelled word list for your entire selected site loads in the viewer area. Click the misspelled word and
the pages where it appears load in the right panel. Click the page link and as we demonstrated above,
you can click theSource tab and go directly to the misspelled word in the code without scrolling, or you
can view the highlighted text in theBrowser tab view.
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In theBrowser tab view, once the page launches, you can use the standard <Ctrl+F> keyboard
command to search the misspelled word on the page.
Click on theMisspellingsHighlightedbutton at the top right of the page to display information

Crownpeak DQM is highlighting misspellings on this page.
If you can't see them, it is probably because they are:

● within a layer or menu that needs to be clicked on to see
● within code that has been commented out
● only visible to users without stylesheets or Flash
● within an element not designed to appear on the page

Try selecting theSource (code) view to see them all.
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Using the Search Function

Taking inventory

The Inventory tab, as its name implies, lists all the assets of your website by category. Each asset type,
such as Images,displays the count of that type of asset and is an active link that provides the pages of
occurrence and their links.

FileAssetsare listed by: Images, Acrobat Documents, Word Documents, Excel Documents,
PowerPoint Documents, ZIP Files, CSS Files, All Flash Files, WMV Files, Flv Files, Mp3 Files, Mp4 Files and
JavaScript Files.

ContentAssets are listed by: All emails used, Title tag frequency, Links to external websites, All data
collection forms,

Metadata is listed by: Pages without metadata keywords, Pages without metadata description,

Cookies are listed by: Pages using Facebook widgets that set cookies, Pages using Twitter widgets
that set cookies, JavaScript files setting cookies, Persistent cookies by type, Pages using HTML5 local
storage code, Pages using HTML5 session storage code.

TheAccessibility Tab

TheAccessibility tab is a rich source for WCAG compliance information. From this page you can
analyze and correct all issues that might limit accessibility to your web content. Your chosen target level
is displayed at the top right of the screen. Here, it displays as: Your target is WCAG Level AA
compliance.
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You can choose the target levels to display here, by checking one or all of the following: Level A, Level

AAor Level AAA. You can also toggleHideSuccessCriterionwithout automated tests. The top-left
panel displays the number of issues for each level and their benchmarking score, with a ranking from
1−10. Each link on the right takes you to the specific W3 Consortium checkpoint. As with all other
checkpoint pages, drill down from the topics listed on the left to see additional detail and link to
a�ected pages. Not shown below, the checkmark icon indicates no issues were found, but manual
testing is still required.
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HowdoesDQMcheck for broken links?
WhenDQM scans your site, it records every single link it encounters. Each of these links is tested to
check whether it should be flagged as broken, using HTTP response codes returned from the server.

The table below details how DQM handles HTTP response codes, by type.
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HTTP Response
Code Marked as a broken link? What the code indicates

400-499 Yes
Codes that fall within this range indicate
an error with the page. Common statuses
such as 404 fall within this range.

401 No

This code indicates that authentication
is needed to reach the page that has not
been provided. The classification is
"unauthorized".

403 No

This code indicates that the server
understood the request, but has
refused to fulfill it. The classification is
"forbidden".

407 No

This code is similar to the 401
classification, but indicates that the
DQM should authenticate itself with the
proxy. The classification is "proxy
authentication required".

500-599 No

This code indicates that the server could
not service the request made by the
DQM. This can occur sporadically when
the server gets busy.

300-399 Link check is repeated on redirected
URL

This code indicates that the server is
redirecting the DQM to another page.
The DQM link checks the new URL also.
To prevent these redirect loops, a rule
marks a link visited more than seven
times sequentially as broken.

200-299 No

Codes that fall within this range indicate
a successful response. These site
pages are also checked to see if the
page in question is an error page.

These default responses can be modified if required. Contact your implementation representative, if
you'd like to discuss this.

Other reasons links canbemarkedasbroken

Along with the HTTP server codes above, a link will also be flagged as broken if an error occurs at any
part of the page's download process. Reasons for such errors include:

● The Host part of the URL is not valid
● An issue with downloading the page via SSL
● An attempt to connect or read times out. Connects time out at 1 minute, reads time out at 2

minutes
● Illegal characters in the URL
● Illegal characters in the URL that DQM is redirected to
● The response code indicates a redirect, but gives no URL for the redirect

Excluding links from the link-checkingprocess

DQM can ignore URLs, or parts of URLs that do not need to be checked. For example: login pages.
Contact your implementation representative if you would like to add some broken link exclusions to
your DQM configuration.
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Reducingerrors reported inWebsiteDQMReports

Our goal is to make Website DQM reports as meaningful and concise as possible by reducing
unnecessary or unwanted errors. Here are some areas that can inflate the error count:

● Third Party code that we do not own or author
● Client-authored documents
● Page source content

Broken links
CMS scans the content of *.pdf and *.doc files for broken links. Broken links from legacy documents
included with broken links found on pages can also inflate error count. CMS can exclude certain URLs or
parts of URLs, reducing the number of reported errors for broken links.

The list of full or partial URLs must be provided and placed on an exclusion list. We can also request that
URLs ending with designated extensions be ignored, such as: .pdf, doc, ppt or others. Once provided,
DQM will skip scanning for broken links inside these types of client document

Alternately, the2.10PDFs–Documentswithbroken linkscheckpoint can be suppressed completely
on client request.

Errors can sometimes be flagged in more than one checkpoint. Errors flagged by the 2.10 checkpoint
can show up in both2.1 Brokenexternal linksand2.2Broken internal links.

Cautionarypoints
When requesting exclusions by full or partial URL, consider if there are other pages or assets that share
the full or partial URL with the *.pdf files. If there are other assets that would be a�ected by an exclusion
by URL or partial URL, then be sure to specify the file extension in the exclusion. You can also describe
the end result you are hoping to achieve to your implementation representative, who can give you
suggestions on how best to exclude specific files.

ADAMContent

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 181



Adding American Accreditation HealthCare Commission (ADAM HRA) content will cause error counts in
most checkpoints to escalate. This content contains many images and image maps without alt
attributes. There are also errors that get flagged forRichMediacheckpoints.

As we do not have any control over the ADAM code, a request to exclude all ADAM content from being
scanned will be needed. ADAM content is onion-like; it is not a single product but a collection of
product IDs, therefore ADAM exclusions are defined by individual product IDs.

Once ADAM has been successfully excluded from the Website DQM scan, it can again show up if a client
adds a new or di�erent product ID. When clients update or add new ADAM products to their site, we
need to request a re-scan and provide notification of the new product IDs.

ADAM exclusions can require some fine tuning. Following is a helpful chart and some tips that should be
helpful.

Indicate the exact product ID (productId) used by the client.

PRODUCTNAME
INCLUDEDWITHADAMSE PRODUCTID=127  PRODUCT ID

ADAM Health Illustrated Encyclopedia Multimedia productId=117

Thomson Drug Notes productId=45

ADAM Wellness Tools productId=20

ADAM Health Navigator productId=65

ADAM Pregnancy Health Center productId=14

ADAM Complementary and Alternative Medicine productId=33

ADAM Health Illustrated Encyclopedia Multimedia (Catholic filtered) productId=5117

Thomson Drug Notes (Catholic filtered) productId=5045

ADAM Wellness Tools (Catholic filtered) productId=5020

ADAM Health Navigator (Catholic filtered) productId=5065

ADAM Pregnancy Health Center (Catholic filtered) productId=5014

ADAM Complementary and Alternative Medicine (Catholic filtered) productId=5107

MyCheckUps productId=43

Tips
Use the word “article” in the exclusion rule; for example, request exclusion of all URLs that have the
following string: “article?productId=43”, “article?productId=65”, “productId=5107”, etc.

ALL CONTENTS ARE CONFIDENTIAL

Confidential © Copyright 2023 WebMD Ignite. All rights reserved.
May not be reproduced or redistributed without the express permission of WebMD Ignite. 182



You cannot refer only to “productId=127”; you must list each productId included in SmartEngage to
successfully exclude ADAM content.

Clients might be using older ADAM products or contract directly with ADAM for their 3rd party content.
Some URLs for article pages might be using ADAM2004_ or other similar URL parameters. ADAM o�ers
mixed content, so it is a good idea to also exclude the following:

● adam.com
● www.adam.com
● http://adam.com
● https://ssl.adam.com

The following are examples of other exclusions asked for on behalf of our clients. They are specific to
those clients but will give you an idea of how to request exclusions.
You should exclude code found in HTML comments. At least one client had commented out code in the
page source of at least 90% of the pages. The commented-out code contained <img> tags without alt
attributes. As the code was throwing errors, the following exclusion was asked for:

Please exclude any <img> tag with or withoutaltattributes found inside a comment tag.
The comment tags being used are <!--- --->, but also we should exclude <!-- --> comments as well.
Example, there are places in the page source similar to the following:

Images fromcross-site origin or external sources
For clients using forms which include buttons and images from an external source, you can ask to
exclude scanning image tags that contain specific URLs For example:

Please exclude any <img> where the src is https://bbox.blackbaudhosting.com/webforms/images/.
Since the image is coming from a source over which we have no control to change, we should exclude
this from being reported as an error.

Example, the following is found in the page source:
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Default imageswhich are used for displayor decorationonly
You can exclude certain image tags from the scan, but these images must have an alt attribute in the
<img> tag. They must be able to pass the “3.1 All images should specify an “alt” attribute” checkpoint.
If the decorative or presentation role image passes the 3.1 checkpoint, but is flagged by the “3.3 Image
alt attribute should not be empty, except for on known, decorative images” checkpoint, you can
exclude it from the scan by asking for the following:

Any <img> tag where the image file name has "_default_"
In the class ih-blog ih-blog-detail is see images that are decorative.

Example, the following can be found in page source:

<div class="ih-blog ih-blog-detail">
<img src="/assets/images/news/news_default_front_hospital.jpg" alt="" class="img-responsive"
itemprop="image"/>

But, remember: the <img> tag must include an alt attribute (alt=””); this tells accessibility technology to
ignore and not attempt to read the alt as it is NULL. The criteria for an image to be considered
“decorative” are:

● the image is not used as a link
● the image is decorative; if it was removed, no information would be lost
● the <img> tag includes an empty alt attribute (alt=””)

Turningo�or suppressing checkpoints
Some clients have requested to turn o� or suppress certain checkpoints. Before turning o� or
suppressing a checkpoint, consider the following:

● Is the checkpoint evaluating a key accessibility level? If it is turned o� will the website not reach
the accessibility goal the client wants to achieve?

● Is the checkpoint being turned o� only to cut down on the error count? If so, the error will still
be present and it might not be noticed. Also disabling one checkpoint doesn’t mean the error
will disappear, it might show up in another checkpoint.

Other FrequentlyAskedQuestions (FAQ)
Howdoes thecrawl of the site a�ectperformance?
The running site crawler is equivalent to a one-person page hit.

Howmanycheckpoint issues comewith theplatform?
There are 77 standard checkpoint issues. You can customize these standards for both code and
content, including by country. You write the logic. There are also complex checkpoints in place for
twitter tags and attributes, client IDs, etc.

Whatbrowsers does theDQMPlatformsupport?
The DQM Platform supports the following browsers:

● Internet Explorer 11.0
● Latest version of Firefox
● Latest version of Chrome
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Browser support

CMS DQM supports the following browsers:
● Internet Explorer 11.0
● Latest version of Firefox
● Latest version of Chrome

Logging in to theDQM
Access the new DQM by using a link. http://dqm.crownpeak.com/

Another point of view, thewebsitedashboardoverview (18)
● The online DQM Website Dashboard also known as the Analyzer.
● There are five tabs: Overview, Issues (with options: Priority issues, All issues, Issues by topic,

Worst pages), Spelling, (with options: Misspellings by word, Misspellings by page) Inventory and
Accessibility.

Issues:Categories and rules
Most of your time will be spent within Issues. Issues can be designated as prioritized. Standards can
range from content presentation, links and images to URL structure and cookies. You can view the full
list of Issues, as shown.

Working with these tools empowers your content management team, by reducing the chance of
introducing compliance issues, so they can focus on creating conversion-centric content for your
organization.
 
You can have as many websites in the platform as desired and administer each one on a separate
dashboard.
 
The table on your screen lists all the rules from this page. Use the scrollbar to view them all.

Managing your SEOusing theDQMOverviewDashboard screen
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To quickly manage your SEO using the DQM Overview Dashboard screen, go to the Issues tab and
select Issuesby Topic.

From this screen, select the SEO category.

The issues that are pertinent to SEO optimization are provided by topic: Content Presentation, Links,
Images, Rich Media and Titles and Metadata. Each category displays the number of occurrences.

Expand a category to immediately address those issues, in context from the Overview page. Let's look
at one of the major issues that directly a�ects not only your site's ranking but user experience and
response, Page Load Performance. You can speed up page loading time by optimizing your images,
with the goal of making file sizes as small as possible, without sacrificing image quality.

Large images slow down page download, which can cause visitors to leave your site and go elsewhere,
a�ecting the time spent on that page. This is an important ranking factor that tells Google how relevant
your page is to visitors.

Note:Page download speeds of more than one second are subject to search engine penalties when
exceeded, and a�ect not only consumer engagement but whether that consumer will ever return to
your site.

Google estimates that 61% of users are unlikely to return to a mobile site they had trouble accessing
and 40% visit a competitor’s site instead.

Here, we clicked Images larger than 500 KB. View the images under this category by thumbnails or
filenames and sort by size or date. Click on an image to see additional properties and a list of how many
pages in your site the image is linked to, listed by links to each a�ected page in your site, so that you can
address the issue and see the result.
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Addressmetadata keywordsbypage

Remember those keywords we discussed earlier? You can quickly analyze and address their usage in
every page of your site, by going to Issues by Topic > TITLE & METADATA, you can view pages without
Metadata Keywords or Metadata Descriptions, with counts and a link to each individual page. Once a
result link is clicked, you can sort page results in ascending or descending order by date, name and size.
Rules below are:

● Pages should contain metadata description
● Limit <title> tags to 60 characters or less
● The title tag should contain the company name
● Do not use multiple title tags

Optimal keyworddensity andmodernSEOpower strategies and tips
Remember those keywords we discussed earlier? You can quickly analyze and address their usage in
every page of your site, by topic, with counts and a link to each individual page. Once a result link is
clicked, you can sort page results in ascending or descending order by date, name and size. You can
achieve maximum search engine e�ectiveness, by utilizing some strategies with this powerful tool. The
following page elements are the best places to use keywords for maximum impact on your rankings.

MetaDescription Tag 

The content of this tag displays on the search engine results page, below your Page Title. This tag
should be on every page and customized by page. Quickly address all pages without this tag from one
location by going to Issues > Issues by Topic > SEO > TITLE & METADATA. The Website Dashboard
Analyzer returns results and links for pages breaking configured meta description rules such as:

● Pages should contain metadata description

Title Tag

This is not the Page Title. This text displays in bolded blue text on Google search engine results pages.
Also, under Issues > Issues by Topic > SEO > TITLE & METADATA are rules such as:
Limit <title> tags to 60 characters or less
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The title tag should contain the company name
Do not use multiple title tags

Page Title

This is the actual page title your visitors see on the pages of your site. Don’t use images, include your
keywords, and enclose in an <h1> tag. Access and address under Issues > Issues by Topic > SEO >
Content Presentation.

HTMLand JavaScript

SEO ranking calculation evaluates how high up on the page keywords appear. Externalizing JavaScript
leaves more room in the top portion of your pages’ code.

Site Text

Utilize your keywords well in the text of your site, but with an eye toward high readability. 3−6% density
is a good rule of thumb to avoid the risk search engine spam labeling.

Keywords in Links

Use your keywords in the links on your site and in the Name Attribute of your link tags, as well as in your
sidebar and footer.

Alt Tags

Each image on your site should have an Alt Tag.2 Alt Tags are important for 508 compliance screen
readers, such as Job Access with Speech (JAWS), which generates audial speech and Braille output for
users with vision impairment. You can also utilize this descriptive text to include your keywords!

Address every page with missing alt tags by clicking Issues > Issues by Topic > Images.

2 An alt tag, also known as "alt attribute" and "alt description," is an HTML attribute applied to image tags
to provide a text alternative for search engines. Applying images to alt tags such as product photos can
positively impact an ecommerce store's search engine rankings.
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Note:Non-compliance can be a costly mistake for websites that do not provide accessibility to all.

Filenames

Filenamesof pages and images are another place to include your keywords. Filenamesdisplayed in
page URLs and using keywords here can really help your rankings. Optimize those URLs using the LINKS
category under Issuesby Topic>SEO.

YourDomainName

Use your primary keyword in your domain name, if possible for considerable improvement in your
rankings, because this implies to the search engine that the entire content of your site is centered
around your keyword.

http://www.wordstream.com/meta-tags

Supportedbrowsers forCMSandCrownpeak
Below is a list of the browsers that are currently supported by both CMS and Crownpeak. These
browsers have been tested and support both PC and Mac operating systems.

● Latest version of Chrome
● Latest version of Safari
● Latest version of Edge

Other browsers (Firefox, Brave, Opera, etc.) may also work, however, these, as well as older versions of
those listed above, may not o�er the same experience and functionality of the most recent versions of
our supported browsers.

Questions?
While one of the most obvious advantages of CMS's features is its ease of use, we understand that you
may have questions. Should you need additional training on a specific capability of the CMS
application, or just need to develop a deeper understanding of how to most e�ectively wield its
powerful potential, please reach out to our responsive delivery or support teams.
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